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Introduction to Parallels RAS 

Terminology 
A category consists of a number of settings related to a specific task or operation. In the Parallels RAS 
Console, the following categories are available: 

• Start
• Farm
• Load Balancing
• Publishing
• Universal Printing
• Universal Scanning
• Connection
• Client Manager
• Policies
• Administration
• Information
• Reporting
• Licensing
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Start 
The start section consists of three sub-sections which will help in configuring Parallels RAS. These sections 
are “Add RD Session Hosts,” “Publish Applications,” and “Invite Users.” The “Add RD Session Hosts” section 
configures and adds RD Session Hosts to Parallels RAS. The second section, “Publish Applications,” 
consists of a wizard which sets up published applications for users. Finally, the “Invite Users” section 
sends out invitations via email to specified users, guiding them in using and downloading all the 
necessary applications to allow them to use the published applications and desktops they want. 

Farm 
A farm consists of a Parallels RAS installation on a site or multiple sites. 

Licensing Server Site 
The licensing server site is where the main configuration database is stored. This manages all other sites 
in the Parallels Farm. Other servers in a site can be upgraded to licensing server status if the main 
licensing server is not available. 

Publishing 
The act of making items installed on a Remote Desktop Server, VDI Host, or Remote PC available to the 
users via Parallels RAS. 

Publishing Agent 
The Publishing Agent provides load balancing of published applications and desktops. 

RDS 
RDS stands for Remote Desktop Services and is a server role in Windows Server that provides technologies 
that enable users to connect to virtual desktops and session-based desktops. RDS replaced Terminal 
Services as of Windows 2008 R2. 

Site 
A site consists of a publishing agent, a Secure Client Gateway, or multiple gateways and the agents 
installed on the RD Session Hosts, VDIs, and PCs. 

NOTE: Upgrades of Parallels RAS MUST be applied to the licensing server site first. 
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Parallels RAS Description 
Parallels RAS enables people to work from anywhere with virtually any device. It’s a powerful tool that 
allows businesses to leverage their existing applications on multiple devices with client support for PC, 
Mac®, Linux, iOS, Android, HTML5, and Google Chrome™. 

Some of the key benefits of Parallels RAS are: 

▪ Centralized resources that can be more effectively managed from both a cost and security
perspective.

▪ The cost of software updates can be reduced with volume licensed copies that can be
shared instead of a full individual copy for every user.

▪ Users’ RD Session Hosts access can be strictly controlled with security groups and group
policies, i.e. software cannot be installed or downloaded on RD Session Hosts. SSL
connections and second-level authentication can be used to create a secure environment.

▪ Applications can be delivered to users on multiple OS platforms for both desktop and mobile
devices.

▪ The Parallels client is available for Windows XP, 7, 8, 10, Raspberry Pi, OS X®, and Linux
desktop operating systems.

▪ The Parallels client is available on iPhone®, iPad®, and Android tablets and phones.

▪ The Parallels HTML5 client provides access from any device with an HTML5 browser.

▪ High Availability Load Balancer Appliance (HALB)

▪ The Parallels HALB is a software solution that sits between the user clients and two (or more)
back-end Parallels RAS gateways. Any number of HALB services can be running concurrently.
At any one time, one is set as the master while the others are set as slaves.

▪ Not only does the Parallels HALB distribute the requests to the two back-end servers, it also
checks the health of the back-end servers. If one of them is down, all requests will
automatically be redirected to the remaining back-end server.

▪ Load Balancer

▪ The load balancer nodes monitor each other using Keepalive service. If the master fails, a
slave becomes the master, which means that the users will not experience any disruption
of service.
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▪ Parallels Desktop Replacement

▪ Parallels Desktop Replacement allows you to extend the lifespan of your hardware and delay
migration to the latest OSes to a time that suits you best.

▪ The Parallels solution allows you to be very flexible. You can lock machine configuration on the
user side, placing your corporate data in an extremely secure position, or you might decide to
allow users to run some local and remote applications.

▪ Parallels Client Desktop Replacement is able to reduce the operability of the local machine by
disabling the most common local configuration options, while guaranteeing the same level of
service and security afforded by thin clients directly from your existing PCs.

▪ Parallels RAS Reporting Service
▪ Parallels RAS has a built-in reporting engine, which the administrator can use to

understand how the system is functioning. The information provided can help in
adjusting the system to perform better and be used in a more efficient way. With it,
you can detect bottlenecks that can lead to future problems, thus avoiding them. You
can also analyze how your users are using the system and extract important statistics.

▪ The system provides 13 reports which are grouped into five categories. You can view
the available reports in a flat view by clicking the flat view button in the reports header,
as shown in Section 16 of this document.

▪ The reports are displayed in two chart types—a bar graph or pie chart—giving you the
ability to toggle between two graphical configurations.

▪ Business Continuity and Disaster Recovery
▪ Application downtime is reduced with redundant systems and quick client build

times.

▪ Parallels RAS also has built-in backup capabilities.



Parallels RAS Training Manual 
13 

Installing Parallels RAS 

S E C T I O N 2 

Installing Parallels RAS 

In This Section: 

Planning and Implementing Parallels RAS ................................................................... 14 

Basic Functionality ................................................................................................ 15 

System Requirements ................................................................................................. 16 

Hardware Requirements ....................................................................................... 16 

Software Requirements ........................................................................................ 17 



Parallels RAS Training Manual 
14 

Installing Parallels RAS 

Planning and Implementing Parallels RAS 
There are three major mechanisms required to deliver published items. 

1 Servers – Connect users to applications, desktops, folders, or documents. There can be a 
single or multiple servers configured to deliver published items using the following agents using 
RDS. 

▪ Gateway*

▪ Publishing Agent*
▪ Remote Desktop Session Host/Terminal Server Agent (used to

publish applications using RDS)

▪ VDI Host Agent (used to publish virtual desktops)

*Required.

2 Clients – May be a PC, tablet, or phone which the Parallels Client is installed on and can 
connect to the published items. A list of available Clients as is follows: 

▪ Windows 7, 8, 8.1, and 10 in 32bit and 64bit

▪ Mac OS X

▪ Linux

▪ iPad
▪ iPhone

▪ Android

▪ HTML5

3 Network – Consists of a LAN or WAN connection. 

▪ LAN connections are on port 80 by default.

▪ WAN connections can be made on port 80, but SSL on port 465 is recommended. Any port
available from outside the network is forwarded to the gateway.
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Basic Functionality 

Figure 1 – Basic Functionality 

Figure 1 shows the basic functionality of an environment consisting of clients and a server over a network. When clients 
request applications, RDS desktops, VDI desktops, folders, documents, or remote PC access, Parallels RAS delivers them 
to the client utilizing RDS. 
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System Requirements 
Before installing Parallels RAS, please verify that your hardware and software meet or exceed hardware 
and software requirements described below. Please note that although Parallels RAS can be used in 
Workgroup environment, Parallels recommends using Active Directory to manage users, groups, and 
machine accounts via group polices. 

Hardware Requirements 
Parallels RAS is extensively tested on both physical and virtual platforms. The minimum hardware 
requirements approved to run Parallels RAS are outlined below. 

• Physical Machines – Dual-core processor and a minimum of 4 GB RAM
• Virtual Machines – Two virtual processors and a minimum of 4 GB of virtual hardware memory

The server hardware requirements to install and configure Parallels RAS can vary according to end-user 
requirements. 

Typically, for an installation of 30 users or under, Parallels RAS can be installed on one high specification 
server and the resources published directly from it. For more than 30 users, multiple servers may be 
required. 

The below should be considered during the planning stage of a Parallels RAS deployment: 

• High specification servers should be used, consisting of multiple CPU cores, a high specification
disk transfer rate, and plenty of RAM.

• A hypervisor-based virtual machine can be used as long as the resources required by the end users
are calculated accordingly.

• RD Session Hosts should not exceed 50 users per RD Session Host in usage.
• The Secure Client Gateway should not exceed 200 users per server for incoming connections.
• When planning VDI hypervisor resource requirements, extra requirements such as RAM usage per

virtual machine and disk space should be taken into account.

For port requirements, please see the Port Reference section. 
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Software Requirements 
Parallels RAS Publishing Agent and Parallels RAS Secure Client Gateway 
Parallels RAS Publishing Agent and Parallels RAS Secure Client Gateway are supported on the following 
operating systems: 

• Windows Server 2008
• Windows Server 2008 R2
• Windows Server 2012
• Windows Server 2012 R2
• Windows Server 2016

As a note, Parallels RAS Secure Client Gateway runs as a 64-bit process and takes advantage of multi-core 
and multi-CPU hardware. 

Parallels RAS RD Session Host Agent 
Parallels RAS RD Session Host Agent is supported on the following operating systems: 

• Windows Server 2003 SP1 and newer
• Windows Server 2008
• Windows Server 2008 R2
• Windows Server 2012
• Windows Server 2012 R2
• Windows Server 2016

Parallels RAS VDI Agent 
Parallels RAS VDI Agent is supported on the following operating systems: 

• Windows Server 2008
• Windows Server 2008 R2
• Windows Server 2012
• Windows Server 2012 R2
• Windows Server 2016

VMware, Nutanix, and XenServer can use a Windows-based VDI agent installed on Windows Server 2012 
R2 and Windows Server 2016. 

Note: Parallels RAS should NOT be installed on a domain controller or any other server 
where a DHCP server is running. 
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Parallels RAS PowerShell 
Windows Server 2008 with Service Pack 2. Windows Management Framework 3.0 must also be installed. 

Parallels RAS Console 
• Windows Server 2008 and newer
• Windows 7 and newer

Parallels RAS Guest Agent 
• Windows 7 and newer

Remote PC Agent 
• Windows 7 and newer

Parallels Client 
Parallels Client is approved for the following operating systems (both 32-bit and 64-bit systems are 
supported, where applicable): 

• Windows 7, 8.x, and 10
• Windows Server 2003 SP1 and newer
• Windows Embedded
• macOS 10.7.3 and newer
• iOS 7.0 and newer (iPhone and iPad)
• Android 2.2 and newer
• Chrome OS
• Ubuntu 12.04 LTS
• Ubuntu 14.04 LTS
• openSUSE 12.3
• openSUSE 13.2
• Fedora 20
• Xubuntu 15.10
• Raspbian OS Wheezy
• Raspbian OS Jessie
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Configuring Parallels RAS 
After a default installation of Parallels RAS, the following services will be running on the server. 

▪ Parallels Publishing Agent – Provides load-balanced applications and desktop publishing.

▪ Parallels Redundancy Service – Provides redundancy to Parallels RAS.

▪ Parallels Secure Client Gateway – Tunnels all traffic needed by Parallels applications on a single
port and provides secure connections.

▪ Parallels RDSH Agent – Provides terminal server information to Parallels Publishing
Agent. 

The Farm and Components 
There are several components that make publishing items possible, which include: 

▪ Application Server

▪ Farm

▪ Publishing Agent
▪ Secure Client Gateway

Agent

▪ RD Session Host Agent

▪ VDI Host Agent

▪ Guest Agent
▪ PC Agent

Troubleshooting Tip: Check the service state when an agent status is “Not Verified.” 
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Parallels RAS 
Parallels RAS is the collective components, systems, and graphical interface of a farm setup. The 
Farm Design view shows all systems managed by the Publishing Agent. 

Figure 2 – Parallels RAS Interface 

The categories in the left pane of the console provide access to the individual systems of Parallels RAS, 
as shown in Figure 2. Selecting an icon provides access to properties, options, configuration settings, 
and the ability to enable and disable them depending on the system. 
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The Farm 

Figure 3 – Farm Info 

The farm contains one or multiple sites that are configured to deliver published items, manage thin 
clients, and access the properties of those components. From the Farm section of the console, 
administrators can: 

▪ Change the name of the farm.

▪ Add a site.
▪ Change the properties of a site.

▪ Delete a site.

▪ Check the agent.

▪ Switch sites.
▪ Change licensing server site.
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Publishing Agent 
Parallels RAS Publishing Agent provides load balancing of published applications and desktops. A Parallels 
RAS Publishing Agent is automatically installed on a server on which you install Parallels RAS and is 
designated as the master Publishing Agent (PA). Each site must have a master Parallels RAS Publishing 
Agent but can have secondary agents added to it. The purpose of secondary agents is to ensure that users 
do not experience any service interruption due to a possible failure of the master Parallels RAS Publishing 
Agent. 

Secure Client Gateway 
The gateway provides clients with a connection point to Parallels RAS and an entry point for the 
connection broker for Wyse terminals. The connections can come from multiple sources, such as a 
Windows, Linux, Mac, or smartphone client. When a connection request is received by the Secure Client 
Gateway, it will seek out information from all Publishing Agents to see if the requesting user has 
permission to access the requested resources. 

The gateway also delivers and installs Parallels Desktop Replacement and Windows PC Client Management. 
It can also tunnel HTTP traffic to an intranet. 

This is processed in the following order: 

1 Gateway receives a connection request. 
2 Gateway forwards the request to the Publishing Agent. 

3 Publishing Agent performs load-balancing checks and looks up the Active Directory security to 
obtain security permissions. 

4 If the user is requesting a published resource and has been granted access, the publishing agent 
returns the response to the gateway service and RD Session Host from which the end user can access 
the service. 

5 Depending on the connection mode, the client either disconnects from the gateway and connects 
directly to the RDS Server (Direct Mode) or asks the gateway to open a tunnel to the RD Session Host 
(Gateway Mode). 
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RDSH Agent 
The RDSH Agent is installed on RDS servers to provide a connection to the farm, which allows the 
Publishing Agent to publish applications and manage them. From the Properties tab, the agent settings, 
RDP printer format, and scheduler can be configured for the RDSH Agent. 

VDI Host Agent 
The VDI Host Agent is installed on the hypervisor host or appliance (i.e. vCenter) to connect the host to 
the farm. From the Properties tab, the host can be removed from the farm. Agent settings, RDP printer 
format, and scheduler are located in the properties of the VDI Host Agent. 

Guest Agent 
The Guest Agent allows the Publishing Agent to publish and manage guest virtual machines (VMs). In the 
advanced settings, you can manage/control the guests, change settings, or update agents. 

Remote PC Agent 
The Remote PC agent is used to connect physical (vs. virtual) PCs to the farm and gives users access to 
those PCs. From the Properties tab, the Remote PC can be removed from the farm. The agent settings 
and RDP printer format are also found in the Remote PC Properties. 

Configuring Parallels RAS 
After installing Parallels RAS, there are specific components that need to be configured depending on the 
environment. For publishing, a Gateway and Publishing Agent are required as well as a RDSH Agent, VDI 
Host Agent, or Remote PC Agent depending on what is being published. The most common use of 
Parallels RAS is to publish applications from an RDS server to a client. This scenario requires a Gateway, 
PA, and RDSH to deliver applications to clients. The following sections will describe the configuration 
process for all the agents. 
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RD Session Hosts’ Configuration and Settings 
For publishing applications or remote desktops from an RDS server, an RDSH Agent must be installed. The 
agent may be removed from the farm from the Properties tab, which is useful during maintenance. 

The Parallels RDSH Agents go through the TCP port 20003 to communicate and provide information to 
the Parallels RAS Console and the users. 

Troubleshooting Tip: Use the netstat—a command can be used to test if the Publishing Agent has established 
connections to ports 20002 (Gateway) and 20003 (RDS). 
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RD Session Hosts’ Properties 
Properties 

Figure 4 – RD Session Hosts Properties 

The Properties tab allows you to configure the RD Session Hosts. Below you will find the explanation 
of the different configuration properties. 

Server – Specifies the server address.

Description – Specifies the server description. 

Change Direct Address – Select this option if you need to change the address that the Parallels 
Client uses to establish a direct connection with the RD Session Host. 
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Figure 5 – RDS Session Hosts Agent Settings 

Agent Settings 

Each RD Session Host in the farm has a Parallels RAS RD Session Host Agent installed to provide a 
connection between the Parallels RAS and the RD Session Host. 

To use default settings, select the Inherit default settings option. To view or modify the default settings, 
click the Edit Defaults link. 

You can also edit custom settings for a particular server. This is done by clearing the Inherit default settings 
option and specifying the following options 

Port – Specifies a different remote desktop connection port number if a non-default port 
is configured on the server. 

Max Sessions – Specifies the maximum number of sessions. 

Publishing Session Disconnect Timeout – Specifies the amount of time each session remains 
connected in the background after the user has closed the published application. This option is 
used to avoid unnecessary reconnections with the server. 

Publishing Session Reset Timeout – This feature allows you to control how long it takes for 
a session to be logged off after it is marked as "disconnected.” 
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Allow Client URL/Mail Redirection – Select this option to allow HTTP and mailto links to be 
opened using a local application on the client computer rather than the server’s resources. To 
configure a list of URLs which should not be redirected, navigate to the URL Redirection tab in the 
Settings node of a site. 

Preferred Publishing Agent – Select this option if you want to prioritize a specific Parallels RAS 
Publishing Agent in case you have more than one. For instance, you could have an agent for 
more than one server. 

Allow 2XRemoteExec to send command to the client – Select this option to allow a process 
running on the server to instruct the client to deploy an application on the client side. Learn more 
about 2XRemoteExec in the “Using RemoteExec” subsection below. 

Use RemoteApp if available – Enable this option to allow use of remote apps for shell-related 
issues when an application is not displayed correctly. This feature is supported on the Parallels 
Client for Windows only. 

Enable applications monitoring – Enable or disable monitoring of applications on the server. 
Disabling application monitoring stops the WMI monitoring to reduce CPU usage on the server 
and network usage while transferring the information to the Parallels RAS Publishing Agent. If the 
option is enabled, the collected information will appear in a corresponding Parallels RAS report. If 
the option is disabled, the information from this server will be absent from a report. 

Allow file transfer command (HTML5 and Chrome clients) – Select this option to allow for file 
transferring between the server and the client through the HTML5 protocol. 

Allow local to remote drag and drop – Select this option to allow for file sharing by dragging a file 
from the user's device and dropping it in the remote session. 
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User Profile Disks 

Figure 6 – RD Session Hosts User Profile Disks 

User profile disks (UPD) store user and application data on a single virtual disk that is dedicated to one 
user’s profile. Virtual disks are reattached at logon and are completely transparent to the user, so the user 
can save their data or change and save their application settings on what appears to be a local disk. All 
personal data and settings persist when connecting to different computers in a virtual desktop collection 
or session collection. 

To use default settings for user profile disks, select the Inherit default settings option. To view or modify 
the default settings, click the Edit Defaults link. 

Follow these steps to use specific settings: 

1 Clear the Inherit default settings option. 
2 Select the Enable user profile disks option. 
3 Specify a network location where the disks should be created using the Microsoft Windows UNC 

format (e.g. \\RAS\users\disks). 

4 Specify the maximum allowed disk size (in gigabytes) in the maximum size field. 

Note: The server must have full control permissions on the user profile disk share. 
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Desktop Access 

Figure 7 – RD Session Hosts Desktop Access 

The Desktop Access tab page allows you to restrict remote desktop access to certain users. By default, all 
users who have access to remote applications on an RD Session Host can also connect to the server via a 
standard RDP connection. 
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RDP Printer 
The RDP Printer tab page allows you to configure the renaming format of redirected printers. The format 
may vary depending on which version and language of the server you are using. 

Figure 8 – RD Session Host RDP Printer 

To use the default RDP printer settings, select the Inherit default settings option. To view or modify the 
default options, click the Edit Defaults link. 

The RDP Printer Name Format drop-down list allows you to select a printer name format specifically for the 
configured server. 

Select the Remove session number from printer name and/or the Remove client name from printer name to 
exclude the corresponding information from the printer name. 
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Groups 

Figure 9 – RD Session Hosts Groups 

RD Session Host groups can be used to specify which group a published resource should be published from 
when using the Publishing wizard. It is highly recommended to use groups in a multi-server environment 
to ease the management of published resources. 

After you create a group and publish resources from it, you can view the list of resources by right-clicking 
a group and choosing “Show” published resources. 



Parallels RAS Training Manual 
34 

RD Session Hosts 

Scheduler 

Figure 10 – RD Session Host Scheduler 

The scheduler is used to provide administrators with a tool for creating maintenance windows to reboot 
RDSH servers or limit the access to published items during a specified time of day. Select the “Add” 
option to enter time, date, duration, and repeat information. 
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Figure 11 – Disable RD Session Hosts Schedule 

The “Disable” option is used to change the session state of the client connections. This is useful when 
changes have been made to the RDS servers and sessions need to be updated. 
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Session Management 

Figure 12 – RD Session Hosts Session Management 

The Session Management tab page allows you to view and manage current sessions for RD Session 
Host servers. To view the page, navigate to Farm / Site / RD Session Hosts / Sessions. 

The Sessions lists displays current sessions and includes the following info for each session: 

• Server – RD Session Host server name
• Session ID – Session ID
• User – Session owner
• Protocol – Protocol used: Console (Parallels RAS Console connection), RDP (remote user

connected via RDP)

• State – Session state: Idle, Active, or Disconnected
• Logon Time – Last date and time the user logged on
• Session Length – Total sessions duration
• Idle Time – Total session idle time
• Type – Session type: Admin, Published Application, or Published Desktop

Note: You can also open the Session Management tab page by right-clicking a server on the RD Session Hosts tab 
page and choosing Show Sessions. This will open the Session Management tab page with a filter applied to it to 
display only the sessions that belong to the selected server. 
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• Resolution – Client display resolution
• Color Depth – Client display color depth
• Device Name – Client device name
• IP Address – Client IP address

You can sort the Sessions list by any session property. Simply click on a desired column heading to sort the 
list in ascending or descending order. 

You can also filter the list using a single or multiple session properties as criteria. To do so, click the 
magnifying glass icon (top right) and then type a desired string in a desired column. The list will be filtered 
as you type. 

To manage a session (or multiple sessions at the same time), select one or more sessions and then use the 
Tasks drop-down menu to choose from the following actions: 

• Refresh – Refresh the list.
• Disconnect – Disconnect the selected session(s).
• Log Off – Log off the session(s).
• Send Message – Opens the Send Message dialog where you can type and send a message to

the session owner(s).

• Remote Control – Remotely control the selected user session.
• Show Running Processes – Display and manage running processes. See below for details.
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Virtualization 
Virtualization Definition 
Virtualization is the process of multiple systems sharing resources. This allows the system to achieve 
increased utilization of the resources, and consequently an increased return on investment. The 
increased utilization also resolves other issues such as space, power, and centralized control in 
datacenters. 

In hardware virtualization, the host machine is the actual machine on which the virtualization takes place, 
and the guest machine is the virtual machine. 
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Virtualization Layers 
Starting with a bare bones server, a hypervisor is installed and then virtual machines are created and 
managed with the hypervisor. Parallels RAS can then be installed on the virtual machines using Windows 
Server 2003, 2008, 2008 R2, 2012, or 2012 R2. Applications and desktops can then be published and 
delivered to devices. Desktop OSes can also be installed on the hypervisor to publish VDI desktops. 

Published Applications 

Windows Server 
Hypervisors 

Figure 13 –  Virtualization Layers 

Bare Metal 

Parallels RAS Farm Work Stations 
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Hypervisors 
Determining the hypervisor plays a key role in the configuration of a system ready to publish applications 
or desktops, as it determines the features and functionality the system will have. The five most prevalent 
hypervisors on the market today are: 

• VMware ESXi

• Hyper-V 2008 R2

• Hyper-V 2012

• Hyper-V 2012 R2

• Citrix XenServer

When choosing a hypervisor, consider the following: 

• The number of VMs that can be installed on a single instance of a
hypervisor

• Functionality (how easy is it to manage VMs)

• Tools (clustering, failover, backups)

These hypervisors are built on different OS platforms and differ greatly in functionality. Parallels RAS can 
function with all these platforms. 

Planning and Implementing Hosts 
The planning and implementation of a virtual environment has many considerations and choices that need 
to be made before the decision is affected, since an informed choice would greatly benefit the eventual 
setup. These considerations are: 

▪ Virtual storage

▪ Virtual networking
▪ Memory allocation

▪ CPU management
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Virtual Storage 
Virtual storage differs from physical machines; it is more likely for a separate storage device to be used in 
conjunction with VM drives, as opposed to local storage on the actual server. It is critical to the success of 
a virtual environment to choose the right storage device because of disk I/O, array configuration, and 
provisioning. If these three characteristics of storage devices are not properly chosen, VM performance 
will suffer. 

Concerning disk I/O, consider the following characteristics of storage arrays: 

▪ NAS – Low Disk I/O

▪ iSCSI – Moderate Disk I/O
▪ Fiber Channel – High Disk I/O

In addition to disk I/O, another consideration to virtual storage is array configuration. There are three 
predominant types of storage devices: NAS, iSCSI, and Fiber Channel. Each has different characteristics 
for the provisioning of disk arrays. For optimum performance, ensure that the device can create separate 
RAID arrays and therefore separate LUNs over logical LUNs. Logical LUNs are stripped across all the drives 
in and array because the drive is a single large array. The LUNs are created with the management 
software and do not physically isolate storage to specific drives as RAID does. If multiple VMs with high 
disk I/O are on the same array, there may be significant performance issues. 

Provisioning of VM drives can be static or dynamic and, depending on the naming convention, is unique 
to the hypervisor. For example, VMware calls static provisioning “Thick” and dynamic provisioning 
“Thin.” Static provisioning operates the same as creating a physical machine drive, in that when the 
administrator provides the drive for a VM, that space is set aside for that VM only. Dynamic provisioning, 
on the other hand, allows the administrator to set the maximum drive size, but only the necessary drive 
space needed at the time of creating the VM is used on the disk as it grows. This allows for 
oversubscribing the hard-drive space. This makes dynamic drive provisioning a poor choice in a 
production-oriented environment. 

The biggest issue with dynamic provisioning is that the VM’s OS will not know if it has run out of space for 
writing to the disk. This might cause an unrecoverable crash. If this happens, a backup may be used to 
restore the VM, but this can be avoided using static provisioning. 
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Virtual Networking 
Virtual networking follows some of the same practices as physical machines, only implemented in a virtual 
environment. To ensure strong VM performance, separate the storage network from the other networks 
with a separate NIC that is configured on a separate VLAN and virtual switch. Additional NIC’s may also be 
needed if there are VMs that have high bandwidth utilization, i.e. email and SQL servers. 

Another consideration is segmenting the network environment. The industry standard for network 
segmentation is no more than 300 devices on a single VLAN. This is due to broadcast domains and the 
amount of chatter that is generated by devices. If the network has mixed protocols such as VOIP as well as 
IP, the number of devices should be reduced to 100–150, or they should be isolated to different VLAN if 
possible. 

Memory Allocation 
To ensure suitable VM performance, memory must be allocated and managed properly. Some key 
considerations are: 

▪ Avoid over-subscribing memory in production environments.

▪ Monitor memory utilization on VM after creation.
▪ Maintain OS versions and patches as similar as possible.

▪ Use monitoring tools to create alerts for memory issues.

Over-subscribing memory is possible in a virtual environment, though it is not recommended as it will 
invoke the use swap files. 

Most of the time, memory allocation is an educated guess on the administrator’s part and should be 
monitored after the VM is created to determine if the appropriate amount has been allocated. 
Adjustments should be made if the memory is underutilized or over utilized. 

Hypervisors can optimize memory by examining memory files and allowing multiple VMs to utilize the 
same memory page if they are the same. Maintaining servers with the same builds and patch versions 
assists in allowing memory page sharing. 

Motoring tools should be set up to alert administrators when memory issues arise to avoid swap file use 
and prevent degradation in VM performance. 
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CPU Management 
CPU management is another vital part of virtualization and should be considered in planning and 
implementing a virtual environment. Each of the three hypervisor brands mentioned has its own unique 
considerations to manage CPUs. For example, in VMware, the main consideration is CPU % Ready. CPU % 
Ready increases when processors have to wait for instructions sets to be processed. This is a result of VMs 
consisting of different processor configurations, some being single core, some dual, and others quad core. 
The quad-core VMs must wait until four processors are available to execute code. If the CPU % Ready is 
high, VM performance will suffer. 

Look up the best practices of each hypervisor to better optimize the CPU management system your 
hypervisor prefers. 

Configuring Virtual Machines 
Once the planning and implementation of the virtual host has been configured, the next step is to 
configure VMs for deployment. With regard to Parallels Publishing Agents, Secure Client Gateways, and 
RDS servers, here are the recommended practices for VM configuration: 

▪ Install the hypervisor tools.

▪ Sysprep templates.
▪ Turn off UAC.

▪ Configure firewall settings with appropriate ports open or off.

▪ Configure anti-virus exclusions for Parallels RAS and related services.

Hypervisor tools are used to manage VMs from the hypervisor console and are also needed by the 
Parallels RAS for VDI. 

Syspreping templates is important since it ensures that the SID is unique to the VM being created. 

Turning off the UAC ensures that various services can function properly, such as activating Parallels RAS. 

Configuring the firewall appropriately will ensure proper communications between Parallels services. 

Anti-virus programs may interfere with the functionality of Parallels RAS and its services. It may be 
necessary to add Parallels RAS and its services to an exception list in the anti-virus software. 
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VDI Hosts and Configuration 
A VDI Host (host machine) is defined as the computer on which a hypervisor is running one or more virtual 
machines. Each virtual machine is called a guest machine. The hypervisor presents the guest operating 
systems with a virtual operating platform and manages the execution of the guest operating systems. 
Multiple instances of a variety of operating systems may share the virtualized hardware resources. 

Parallels RAS supports VMware vCenter, VMware ESXi, Hyper-V, Citrix XenServer, KVM, and Nutanix. 

By adding the VDI Host to Parallels Application Server, you can manage the virtual machines on the VDI Host, 
create guest clones, and publish virtual desktops and applications from virtual guests. 

The Host Agent is installed on the hypervisor host to publish VDI desktops from Parallels RAS. From the VDI 
Host section of the farm, select “Add” and choose the hypervisor type being used to host clients. 

Figure 14 – Add a VDI 

For some of the hypervisors, such as VMWare ESXi server, you must configure and run an appliance instead 
of the running the Parallels Agent. An appliance is a pre-configured virtual machine (including the operating 
system and other relevant settings) which you can add to the list of virtual machines running on the 
hypervisor to act as a Parallels Agent. 
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Properties 

Figure 15 – VDI Properties 

From the Properties tab, choose the VDI version type and enter the credentials to allow the host access. 

VDI Type – Select the type of the hypervisor that will be used in this VDI host. 

VDI Subtype – Choose the subtype version of the hypervisor to be used. 

VDI Host – Input the server address of the VDI Host. 

VDI Port – The port that will be used for the connections to the VDI Host. 

Description – A description to be shown on the Parallels RAS Console. 

Dedicated VDI host Agent – Select in case of a VDI appliance requirement. Some hypervisors such as 
VMware ESXi require a separate component. Input the component address here. 
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Credentials 

Figure 16 – VDI Credentials 

Enter the credentials to access the VDI Host server. Click on the "Check Credentials" button to confirm 
that the credentials inputted are correct. 
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Agent Settings 

Figure 17 – VDI Agent Settings 

The Agent Settings tab allows the direct address to be changed.  

Max Connections – Define the number of maximum connections allowed to this host. 

Publishing Session Timeout – Used to set the amount of time that each session will stay connected in 
the background after the user has closed all published applications. This is done to avoid unnecessary 
re-connections with the server. The maximum number of connections possible is 1,000. 

Allow Client URL/Mail Redirection – Enabling this allows HTTP and mailto links to be opened using local 
applications instead of using RD Session Host resources. 

Preferred Publishing Agent – Select this option if you want to prioritize a specific Parallels RAS 
Publishing Agent in case you have more than one. For instance, you could have an agent for more than 
one servers. 

Allow file transfer command (HTML5 and Chrome clients) – Select this option to allow for file 
transferring between the server and the client through the HTML5 protocol. 

Allow local to remote drag and drop – Select this option to allow for file sharing by dragging a file from 
the user's device and dropping it in the remote session. 
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RDP Printer 

Figure 18 – VDI RDP Printer Settings 

RDP Printer settings are used to change the name format of RDP printers in all Windows Server versions 
before 2008 and MS Easy Print. 
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Scheduler   
 

 
 

Figure 19 – Scheduler Entry 
 
 

The Scheduler tool provides administrators with a tool for creating maintenance windows for VMs or for 
the host itself. Select the + button under the Scheduler tab to configure a time, date, duration, and how 
often this information should be repeated. 
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Virtual Desktop Infrastructure 
Installing the VDI Guest Agent 
To publish VDI desktops, a Parallels Host Agent must be installed on the hypervisor host server. Each 
hypervisor has a specific manual for utilizing VDI which can be found at: 

parallels.com/products/ras/resources/ 

Installing the Parallels Guest Agent will give the Publishing Agent the ability to publish VDI guests. 

Configuring Pools 
Configuration pools offer administrators more flexibility when managing an extensive number of guests, 
especially when they are implemented in large company infrastructures. The Parallels RAS console provides 
the framework and tools needed to create a complete Pool Management foundation. 

Figure 20 – Pool Management Interface 
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Adding Pool Members to a Pool 

Figure 21 – Adding Members to a Pool 

Select the Pool that you want to add Members to, and then click on the + or "Add" button from the Task 
menu. 

Choose from the following types of guests: 

 All Guest VMs in Host – All guest VMs that are located on a particular VDI host. After clicking this
option, you will be able to select a VDI host

 Guest VM – A specific guest VM located in the farm. After clicking this option, you'll be able to
select a guest VM from the list

 Native Pool – Group of guests that have been previously configured from the hypervisor management
tool. Please note that the hypervisor may use a different terminology to these pools (e.g. resource pools).
After clicking this option, you'll be able to select a native pool from the list, if any are available.

 Parallels RAS Template – Guest VMs that are automatically created from a Parallels RAS Template. After
selecting this option, you'll be able to select a Parallels RAS template.
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Wildcard to Filter VMs 
Use the Wildcard input field at the bottom of the Pool Management tab to specify a wildcard to 
indicate which guest VMs should be available for users. If a VM name matches the wildcard, it will be 
available. If not, the users will not be able to use it. Use the asterisk operator (*) to specify a wildcard 
(e.g. ABC*, *ABC*). 

Pool Guests 

Figure 22 – Virtual Guest List 

The Pool Guests button allows you to view and manage guests in a particular pool. Select a pool, and the 
guests that are included in that pool will appear in the Virtual Guests List. 
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 Guest Advanced Settings 

 Figure 23 – Guest VM Advanced Settings 

When the Guest VM Advanced Settings dialog box appears, you can further configure each Guest VM in the 
Pool. 

▪ Do not use this guest – If you enable this checkbox, the system ignores the particular virtual
guest.

▪ Computer Name – This field allows you to set the network name (domain name/IP address) of
the computer that the system will use to connect to the virtual guest.

▪ Port – In this field the port number that the system will use to connect to the virtual guest is defined.
▪ Connection Timeout – Use this field to set a time limit on the attempts of a Parallels RAS

connecting to a particular virtual guest.
▪ Protocol – This is the method used for Parallels RAS to communicate with the virtual guest.

▪ If session disconnects – You can set what actions the guest will take if a user disconnects from a session by
choosing an option from the drop-down list. You can then configure the amount of time that needs to pass
before the selected action is brought into effect, in the after drop down slist.
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Parallels RAS Templates are used to automate the creation and deployment of guest VMs in Parallels RAS. A 
Parallels RAS Template is created as a copy of an existing guest VM but cannot run as a regular virtual 
machine. You can customize a Parallels RAS Template for use with Parallels RAS according to your needs. 
Once a template is ready, you can use it to create guest VM clones (copies) that will inherit all of the 
properties of the template. Guest VMs can then be used to serve applications, documents, and desktops to 
your Parallels RAS users. 

Parallels RAS Template provides two options: 

• Virtual Desktop – VDI desktops based on Windows Server and Client OS (RDS not supported)

 Use of full or linked clone is available on this option.

• RD Session Host – RD session hosts based on Windows Server OS (Windows 2008 R2 and later)

 Strictly for linked clone usage.

With the use of RD session host linked clones, you can set certain rules in your template to automatically 
scale up or down your servers according to traffic demands. This is another dynamic load balancing feature 
of Parallels RAS implemented in version 16.5. 

Maintenance Mode 
The Parallels RAS Template maintenance mode is used to update software inside a Parallels RAS 
Template. For instance, if you want to install a Windows server pack or a software update, you need to 
use the maintenance mode. 

Depending on whether a Parallels RAS Template is configured for full or linked clones, the maintenance 
mode is used slightly differently. 
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General 

Figure 24 – Parallels RAS Template Properties 

• Template name – Specify a name for the template.

• Maximum guest VMs – Specify the maximum number of guest VMs that can be created from this
template. Once the number of existing guest VMs exceeds this number, a VM is deleted to comply with the
limitation.

• Keep available buffer – Specify the number of VMs that will be automatically created in advance. This is
done in order to have some VMs ready right away. If all VMs are already in use and another one is needed, it
will be created on demand.

• Guest VM name – Specify a name prefix for guest VMs. A VM ID will be appended to it to make the final
VM name unique.

• Delete unused guest VMs – Enable this option to automatically delete VMs that haven't been used for a
specified period of time. Use the drop-down list to specify the time period.

• Clone method – Specify whether virtual machines should be created from this template as full or linked
clones. (See the note and the Full vs. Linked Clones section below for more info). These options are only
available when you create a new Parallels RAS Template; they are disabled when you modify the
configuration of an existing template.
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Full vs. Linked Clones – Guest VMs are created as clones (copies) of a Parallels RAS Template. A full clone is a 
complete copy of a template. As such, it occupies as much space on the physical hard drive as the source 
template and takes a significant time to create. A linked clone is a copy of a template made from a snapshot 
that shares virtual disk with the source template; therefore, it takes much less space on the physical hard 
drive and it takes only a couple of minutes to create. Linked clones have other advantages, such as simplified 
disaster recovery, added security, and single image management, to name a few. 

Advanced 

Figure 25 – Parallels RAS Template Advanced Settings 

On the Advanced page, specify the following options: 

• Folder – Specify the folder where guest VMs created from this Parallels RAS Template will be
stored. This option is available if you are using Hyper-V, Hyper-V Failover Cluster, VMware
vCenter, Citrix XenServer, KVM, or Nutanix.

• Native Pool – Specify the native pool to add the VMs to. This option is only available if you are
using VMware ESX and VMware vCenter.
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Figure 26 – Parallels RAS Preparation Settings 

On the Preparation page, you can select and configure an image preparation tool. First, select whether 
you want to use RASprep or Sysprep. 

RASprep is the Parallels RAS tool that  prepares Windows in a VM after cloning it from a base image. 
RASprep performs the following tasks during the initial startup of each new VM: 

• Creates a new computer account in Active Directory for each guest VM.
• Gives the guest VM a new name.
• Joins the guest VM to the Active Directory domain.
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Compared to Sysprep, RASprep works much faster because it modifies a lower number of configurable 
parameters and requires less reboots. The following table lists the main differences between RASprep and 
Sysprep. 

OPERATION RASPREP SYSPREP 

DELETE LOCAL ACCOUNT No Yes 

GENERATE NEW SIDS No Yes 

UNJOIN THE PARENT GUEST VM FROM THE 
DOMAIN 

No Yes 

CHANGE COMPUTER NAME Yes Yes 

JOIN THE NEW INSTANCE TO THE DOMAIN Yes Yes 

LANGUAGE, REGIONAL SETTINGS, AND DATE 
AND TIME CUSTOMIZATION 

No Yes 

NUMBER OF REBOOTS 1 2 (seal, mini-setup, 
and domain 
joining) 

After selecting the preparation tool, specify the following options: 

• Computer name – A name pattern that should be used to assign a computer name to a VM. For
example, Windows10-RAS-%ID%.

• Owner name – Owner name (optional)
• Organization – Organization name (optional)
• Administrative password – Local Windows administrator password
• Join domain – Name of a domain for the VM to join
• Administrator – Domain account
• Password – Domain account password
• Target OU – Full DN of an organizational unit. Click the [...] button to browse Active Directory and

select an OU.
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License Keys 

Figure 27 – Adding a License Key 

On the License Keys page, specify the license key information that will be used to activate virtual 
machines created from this template. 

First, select the license key management type that you are using in your organization (KMS or MAK). 
Parallels recommend to use KMS because MAK has limited activations. 

Key Management Service (KMS) – If you are using KMS, click the Finish button to save the template 
configuration information. Virtual machines that will be created from this template will look for KMS in 
DNS (at the end of the OS mini-setup and domain joining) and will be activated accordingly. 

Multiple Activation Keys (MAK) – If you are using MAK, do the following: 

1 Click the Add button and type a valid key in the License key field. 
2 In the Max guest VMs field, specify the maximum number of VMs that can be created from 

this template. 
3 Click OK. 

Note: Parallels RAS does not keep the old MAK key in guest VMs if it was updated in the Parallels RAS Template 
properties. 
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Figure 28 – Parallels RAS Test Template Wizard 

If you selected the Launch Parallels RAS Test Template Wizard on completion option on the last page of 
the template configuration wizard, the Parallels RAS Test Template Wizard opens, allowing you to test 
the health of the Parallels RAS Template. The wizard allows you to see that all post-prep activities 
complete correctly. This includes checking DHCP settings, DNS registration, correct VLAN, joining the AD 
domain, correct target OU, and more. 
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How Guest VMs Are Created from a Template 

After a Parallels RAS Template is created, Parallels RAS begins creating guest VMs from it, one VM at a 
time. The number of VMs is determined by the value specified in the Pre-created guest VMs field on the 
Properties page. 

As soon as a user connects to an existing guest VM, Parallels RAS begins creating a new guest VM from the 
template, so the number of pre-created VMs remains unchanged. Please note that creating a new guest 
VM from a template takes some time, especially when a template is configured to create full clones. 
(Linked clones are created much faster.) If a guest VM is in the middle of being created and no other VMs 
are available, the user will have to wait until the VM is ready. 

If a guest VM encounters a problem during the preparation stage (for any reason), it remains on the server 
but cannot be used. You can identify such VMs in the Template Guest VMs List dialog by the "Preparation 
failed" value in the Status column. Unless a VM like this is repaired or recreated, it will be automatically 
removed after the time period specified in the Auto remove guest VMs which failed preparation after 
field on the VDI Hosts > RAS Templates tab page. 

When a guest VM is no longer in use, and if the number of existing VMs exceeds the "pre-created" value, a 
VM is deleted after the time period specified in the Delete unused guest VM after field on the Properties 
page. If you didn't select that option, a VM is never deleted, but the total number of VMs will never exceed 
the value specified in the Maximum guest VMs field on the Properties page. 
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Figure 29 – VDI Persistent Guests 

When a published application from a guest is set as persistent, the publishing agent will create a persistent 
guest rule the first time a user launches the application. The publishing agent will always connect the user to 
the same guest when the persistent rule is used. 

The persistent guests can be viewed and managed on this tab. The information that is provided includes the 
guest name, host IP address, the last time this guest was used, and both the date and time this persistent 
guest rule was created as well as the state of the persistent rule. 

Click on the headings to sort using the column headings. 



VDI Hosts 

Parallels RAS Training Manual 
64 

Figure 30 – VDI Persistent Guests Options 

Click on the “Refresh” button to view new additions to the Persistent Guests list. To delete a persistent 
guest entry, select and click on “Delete.” To delete all the existing persistent guests in the list, click 
“Delete All.” 

Choose to automatically remove “persistence” if the guest is not used for the specified amount of time. 
The options available are 24 hours, one week, or 30 days. 
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Publishing VDI Desktops 
Now the guest can be published by selecting “Desktop” from the publishing menu. 

Figure 31 – Publishing Desktop Step 1 

Select Desktop and click “Next >”. 
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Figure 32a – Publishing Desktop Step 2 

Select the type of desktop you would like to publish and click on the “Next >” button to continue. 

Figure 32b – Publishing Desktop Step 3 

Select the "Guest VM " you would like to publish and click “OK” to continue. 
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Figure 33 – Publishing Desktop Step 3 

Next, you will need to name the guest to be published. A description may also be added to explain 
the guest’s purpose. 

From the “Connect to” menu, select what type of guest to publish next. “Any Guest” and “Guest” will 
give the option to choose what pool to get a guest from. 
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Figure 35 – Publishing Desktop Pools selection 

Then, choose the pool to publish the guest from and select “OK.” Note that all guests are in the 
default pool, but other pools can be created for organizational purposes. 
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Figure 36 – Publishing Desktop Connection Type 

If “Specific Guest” is chosen, then a list will be presented from which the guest specification may be chosen 
from. 

Figure 37 – Virtual Guests List 
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Figure 38 – Select Users/Groups from the Active Directory 

Select the type of filtering to be used and click “OK.” 
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Remote PC Agents 
Remote PC Settings 
The Remote PC Agent is installed on remote PCs (physical machines) as a service. 

Figure 39 – Remote PC Agent Services 

Figure 40 – Remote PC Properties 

The "Properties" tab of the Remote PC Agent allows the remote PC to be enabled or disabled in the farm. A 

description can be added to provide additional information about the remote PC. 

You can configure the direct address by checking the “Change Direct Address” box and entering a new direct 

address. This address is used in Direct Connection mode only. This can be an internal or external IP address, 

depending where the clients will be. If external, the IP address must be assigned by your firewall to your 

server.
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Figure 41 – Remote PC Agent Settings 
 
The “Port” field contains the port number that the system will use to connect to the Remote PC. 
 
Parallels RAS can wake a PC by sending a packet over the network. This will continue until the receipt of 
the packet is acknowledged or until the connection is timed out. In the "Connection Timeout" field, 
choose a time by which the connection automatically times out. 

 
The "Publishing Session Timeout" field allows you to designate a time before the publishing session 
times out, thereby conserving system resources. 

 
Enabling the “Allow Client URL/Mail Redirection” function allows HTTP and mailto links to be opened 
using local applications instead of using RD Session Host resources. 

 
You have the option to choose you "Preferred Publishing Agent" by selecting it from the list, or you 
can let Parallels RAS choose automatically by default. 

 
By enabling "Allow file transfer command (HTML5 and Chrome clients)," you can use the file 
transfer command in those clients. 

 
The option to "Allow local to remote drag and drop" can also be enabled. 
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Figure 42 – Remote PC RDP Printer Settings 

RDP Printer settings are used to change the name format of RDP printers in all legacy Windows 
Server versions before 2008 and MS Easy Print. 
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Remote PCs 
The Parallels RAS install package has a Remote PC Agent which can be deployed in case of several needs 
arising, to meet different end-user requirements. The Parallels Remote Client can be installed on any 
supported version of Microsoft Windows and allows for applications and desktops to be published from 
these workstations. 

 
 

The Remote PC Agent works in a similar way to the Parallels Terminal Server Agent, but it’s designed for a 
standalone PC installation. It uses the RDP protocol to publish desktops and applications from that PC 
much in the same way desktops and applications can be published using the Terminal Server agent. 

 

 

Published Applications 

 
 
 

Figure 43 – Remote PC Graphical Explanation 
 
 

The Remote PC Agent is made available for a variety of different scenarios which may require the 
publishing of a resource from a standalone network computer rather than a RD Session Host or a VDI host. 
The reasons for such scenarios may include: 

 
 

▪ Insufficient licensing for a RD Session Host environment – some applications require a special 
license when installed on RD Session Hosts, making it impossible to publish a particular 
application from a RD Session Host. 

▪ The inability to install on the server – Some applications may have a strict installation requirement 
for legacy versions of Windows or may not be installable alongside certain Windows Server 
services. 

▪ Legacy OS Support – Some applications may not work on newer versions of Windows and may 
only be compatible on older versions of Windows. 

 
 

Microsoft Windows ships with the ability to remotely connect to the machine using RDP with an 
administrator account. However, this is a one-user license, only using the administrator account. 

 

Parallels Client 

 
 

Parallels RASr Farm 
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Prerequisites 
The Remote PC client generally supports all versions of Windows for Windows 7, 8X, and 10. The RDP 
service should be enabled and ready to accept incoming RDP connections. 

Configuring Remote PCs 
The Remote PC agent has more or less the same publishing functionalities and features as other Parallels 
resource agents. For example, the Parallels Universal Printing function can be used and drive redirection is 
supported. 

The settings for the Remote PC agents are editable from the Parallels RAS console, and any changes will 
be pushed out to a Remote PC Agent automatically after applying. Click “Properties” to review the 
settings, which can be changed for a Remote PC agent. 
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Enable Remote PC – Make sure that the “Enable Remote PC” box is checked so the new Remote PC is enabled 
in your farm. In the “Remote PC” field, you can then enter or edit the name of the selected Remote PC. 

MAC Address – Enter the MAC Address of the PC you would like to add. Use the “Get MAC” button if you 
are adding your local machine to easily get the MAC Address. The MAC Address is a unique identifier 
relating to the workstation’s network card or communication hardware used to identify specific machines 
on a network. 

Protocol – The “Protocol” field determines the protocol used by the Remote PC. Only RDP can be used on 
Remote PC; however, other Parallels Resource Agents may allow for ICA remote protocols, for example. 

Description – An area where a summary for this entry can be entered. 
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Agent Settings 

Figure 44 – PC Agent Settings 

The “Port” field contains the port number that the system will use to connect to the Remote PC. 

Parallels RAS can wake a PC by sending a packet over the network. This will continue until the receipt of 
the packet is acknowledged or until the connection is timed out. In the "Connection Timeout" field, 
choose a time by which the connection automatically times out. 

The "Publishing Session Timeout" field allows you to designate a time before the publishing session 
times out, thereby conserving system resources. 

Enabling the “Allow Client URL/Mail Redirection” function allows HTTP and mailto links to be opened 
using local applications instead of using RD Session Host resources. 

You have the option to choose you "Preferred Publishing Agent" by selecting it from the list, or you 
can let Parallels RAS choose automatically by default. 

By enabling "Allow file transfer command (HTML5 and Chrome clients)," you can use the file 
transfer command in those clients. 

The option to "Allow local to remote drag and drop" can also be enabled. 
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RDP Printer 

Figure 45 – PC Agent RDP Printer Settings 

The RDP Printer tab gives you the option of selecting the format of redirected printers. The format may 
vary depending of which version and language of the server you are using. 

Set your RDP Printer Name Format by choosing from the following three options: 

▪ Printername (from Computername) in Session no. 

▪ Session no. (computername from) Printername 

▪ Printername (redirected Session no) 
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Gateways 
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Parallels Secure Client Gateways 
The first gateway will be installed in a farm using the default installation. If a custom install was used and 
the gateway agent was not installed on the same server as the Publishing Agent, it can be “pushed” to the 
server using the “Install’ button located in the gateways section of the farm. 

Make sure that the Parallels Secure Client Gateway has access to port 20002; otherwise, it will not be 
able to retrieve the published applications list and load balance the application requests. 

For more information, see: http://www.parallels.com/products/ras/support/ 

Figure 46 – Gateway Settings 

To configure the gateway, navigate to Farm > Gateways > Server. Right-click and select "Properties." 

http://www.parallels.com/eu/products/ras/support/
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Figure 47 – Secure Client Gateway Properties 

The options to Enable or Disable a gateway and add a Description are available from the "Properties" 
tab. 

The "Preferred Publishing Agent" can be selected as well if there are multiple available. 
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Figure 48 – Gateway IP Address Settings 

The IP Address tab contains a dropdown list of the IP versions that are supported by the Parallels Gateway. 

Parallels RAS also supports IPv6 on the system. If this is selected, the product will still need IPv4 in order to 
work, as IPv6 is introduced at the Secure Proxy Gateway and Connectivity Level. This means that IPv6 is for 
end-user usage in order for tunneling policies to work properly. To ensure that this works correctly, you 
must make sure that the IP Bindings to your physical gateway are set to all available addresses. 
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Figure 49 – Gateway Network Settings 

The “Network” tab contains the port settings that Parallels Clients connect to the Gateway on. 

The default port for the “RAS Secure Client Gateway” is port 80.  

The “RDP Port” setting is used for Load Balanced RDP connections. This can be changed to another 
available port number, but for this change to take effect, it must be changed in the Parallels Client settings 
as well. Changing this port will cause users to append the port number to their connection string in RDC if 
this port number is changed. 
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Figure 50 – Gateway SSL/TLS Settings 

The “SSL/TLS” tab is used to configure settings for secure client connections and to enable the HTML5 
Gateway. The default port for SSL connections is 443, but this can be changed to another available port. If 
it is changed to another port, it will need to be changed in the Parallels Client as well. 

Navigate to the SSL/TLS tab in the gateway properties. The “Enable SSL on Port” option is enabled 
by default. Next, configure a port number (default is 443). 

Optional: Select the SSL version accepted by the Parallels Secure Client Gateway from the “Accepted SSL 
Versions” dropdown listed below (Default is TLS v1 - TLS v1.2): 

▪ TLS v1.2 Only (Strong)

▪ TLS v1.1 -TLS v1.2 (Recommended)

▪ TLS v1 - TLS v1.2

▪ SSL v3 - TLS v1.2

▪ SSL v2 - TLS v1.2 (Weak)

TLS v1.1 – TLS 1.2 is recommended, since other SSL versions may be vulnerable. 



Parallels RAS Training Manual 
86 

Gateways 

Figure 51 – Generate a New SSL Certificate 

A self-signed or a third-party certificate must be installed to use SSL. Select “Generate new certificate” to 
create a self-signed certificate. After the encryption, key size, and information fields are completed, select 
“Save,” and the certificate will be enabled. 
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Figure 52 – Generate SSL Certificate 

To use a certificate from a trusted authority and to enable SSL on a Parallels Secure Client Gateway, 
navigate to the SSL/TLS tab in the gateway properties. Click on “Generate certificate request”, fill in all 
the required details, and click “Save.” 
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Configuring SSL Certificate Details 

Figure 53 – SSL Certificate Request 

Once ready, a window will pop up with the certificate request, as show in Figure 57. Click “Copy” to copy 
the request, which you should then send to the certificate authority. 

Generated Certificate Request 
Once you receive the SSL certificate from the certificate authority, click on “Import public key,” browse 
for the certificate file containing the public key, and click “Open.” 

Click “OK” to save the settings. 

Enabling HTML5 Support 
HTML5 gateway allows connections to published items from HTML5 browsers. SSL must be enabled to 
utilize the HTML5 gateway. Parallels RAS will listen for HTML5 gateway connections on Port 20020. 

To connect to the HTML5 gateway, use the following URL: 

 https://FQDN/RASHTML5Gateway/ 

https://fqdn/RASHTML5Gateway/
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Allow Modification of Parallels and RDP Connections 

Figure 54 – Gateway HTML5 Settings 

Select the “Enable HTML5 Client” option to allow users to create new connections to other gateways or 
modify existing ones, as shown in Figure 54. 

Once a self-signed certificate has been created, HTML5 is automatically enabled. This is done to make the 
product more streamlined and run faster. 

The “Launch sessions using” section enables administrators to select how they would like their users to 
use the Parallels HTML5 Client. There are three options: 

1. Launch apps in Browser only (HTML5 Only) – This enables users to only use the published
applications using only the HTML5 technology.

2. Launch apps with Parallels Client – Although users would be accessing the published
applications through the HTML5 Client, they would still need to download the Parallels Client to
access their applications. This is normally used for a more enhanced experience.

3. Launch apps with Parallels Client & Fallback to HTML5 – This option primarily tries to use the
Parallels Client to access the published applications. However, if the user would not like to use
the Parallels Client, the HTML5 Client would automatically fallback to use the HTML5 technology
to access the published application or desktop.
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Wyse 

Figure 55 – Gateway Wyse Settings 

The Wyse tab allows Wyse ThinOS support from Parallels RAS by checking the “Enable Wyse ThinOS 
Support” checkbox. The Parallels Secure Client Gateway will then act as a Wyse broker. 
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Security 

Figure 56 – Gateway Security Settings 

The Security tab contains settings to allow all or specific connections using the MAC address. Click on 
"+" for either “Allow all except,” or the “Allow only” options to choose which clients to add to the 
particular list. 
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Web Requests 

Figure 58 – Gateway Web Requests Settings 

The Web Requests tab allows you to specify a URL that will open when a user enters the IP address 
of the Parallels RAS Secure Client Gateway server in a web browser. 

Note: The Web Requests tab is only available if the gateway mode is set to normal. 
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Tunneling Policies 
Tunneling Policies are better known as the Load Balancing Rule. With tunneling policies, you are able to 
create an interface that allows you to load balance specific servers or server groups to another 
dedicated IP address. By default, Parallels RAS will load balance all servers that are joined to the server 
farm. 

Figure 59 – Tunneling Policies Tab 

Change the tab to “Tunneling Policies” at the top of the Gateway section to access the Tunneling Policies tab. 
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Configuring Multiple Gateways and Forwarding 
Gateways 
Multiple Gateways 
If more than 300–500 concurrent users connect to a Parallels Secure Client Gateway in gateway mode, 
latency may be experienced due to excessive connections. In this case, a network load balancer, HALB, and 
second gateway can be used to improve performance. Multiple Parallels gateways ensure that client 
connections are maintained at optimal performance, while also provide redundancy to help ensure system 
uptime in the event of a failure. 

Publishing Server 
Secure Client Gateway 
SSL Enabled Gateway 2 

Firewall 

Publishing Server 
Secure Client Gateway 
SSL Enabled Gateway 1 

HALB 

WAN 

Figure 60 – Multiple Gateways 

In Figure 60, both Parallels gateways are configured to forward requests to the same Parallels 
Publishing Agent. 

LAN 
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Forwarding Gateways 
Parallels Secure Client Gateway can forward requests to the next Parallels Secure Client Gateway in the 
chain (Cascading Firewall). To do this, select this option in the “Advanced” tab of the Gateway 
properties. 

In the image below with this option enabled, the Parallels Secure Client Gateway (GATEWAY 1) will forward 
connection requests (on port: 80 by default) to the next Parallels Secure Client Gateway (GATEWAY 2) 
configured in the “Forwarding Parallels Secure Client Gateway(s) list.” 

Forwarding gateways are useful in separating WAN connections from LAN connections, which makes it 
possible to disconnect WAN segments in the event of an issue without having to disrupt LAN connections. 

Publishing Server 
Secure Client Gateway 
SSL Enabled Gateway 2 

Firewall 

Publishing Server 
Secure Client Gateway 
SSL Enabled Gateway 1 

HALB 

WAN 

Figure 61 – Forwarding Gateways 

LAN 
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Third-Party SSL Certificates 
Third-party certificates used with Parallels Secure Client Gateway can be installed with two different 
methods depending on the type of certificate purchased. 

▪ Using Apache Certificates

▪ Converting IIS Certificates

Using Apache Certificates 
1. Go to the Parallels console > Farm > Gateway > Properties> SSL/TLS tab.
2. Choose your SSL settings choices SSL v3, etc.
3. Choose CSR.

4. Fill in the data.

5. Copy and paste the CSR into notepad and save the file for your records.
6. Paste the CSR into the vendor’s website, or email it to the vendor.
7. Request a return certificate in the following format: Apache, all in one single file (which has the

private, public and intermediate CA all in one file), with the pem extension.

8. When you receive this file, place it in a secure folder for backup retrieval.
9. Click the “Import Public Key” button, and browse to this folder or a secondary location where

you have a copy of the single all-in-one certification. Insert this PEM file into the “Certificate
key”  field.

10. Click apply and test.

Note: The private key should already be populated from your initial CSR request. 
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Converting IIS Certificates 
If the same certificate is used for IIS and the Parallels RAS Web Portal, then the IIS conversion method 
should be used. With an IIS certificate, install it in IIS, export a copy of the certificate in pfx format, then 
convert it to PEM file and place the single key generated in the “Private Key” and “Public Key” Field. 

One important note: The trusted.pem file on the Parallels client side must have the intermediate 
certificate in its contents to be able to verify the certification from the third-party vendor. If the 
intermediate certificate for the vendor is not in the trusted.pem file, you will have to paste it in 
manually. Or, you can create a trusted.pem template file with the proper Intermediate certificates in its 
contents and then replace the old trusted.pem file with this newly updated one. This file resides in 
program files\Parallels or program files(x86)\ Parallels on the client side. 

In order to use this certificate onto the Parallels Client Gateway, convert the PFX file to the 
unencrypted PEM format. 

Use the open-source utility OpenSSL to perform the conversion from PFX to PEM. You can download a 
Win32 distribution through the following: 

OpenSSL: gnuwin32.sourceforge.net/packages/openssl.htm 

To convert a PFX file to a PEM file, follow these steps on a Windows machine: 

1. Download and install the Win32 OpenSSL package from:
gnuwin32.sourceforge.net/packages/openssl.htm

2. Create a folder c:\certs and copy the file cert.pfx into the c:\certs folder.

3. Open a command prompt and change into the GnuWin32\bin directory: cd
%ProgramFiles%\GnuWin32\bin

4. Type the following command to convert the PFX file to an unencrypted PEM file: Openssl pkcs –in
c:\certs\cert.pfx –out c:\certs\cert.pem –nodes

5. When prompted for the import password, enter the password you used when exporting the
certificate to a PFX file. You should receive a message that says “MAC verified OK.”

http://gnuwin32.sourceforge.net/packages/openssl.htm
http://gnuwin32.sourceforge.net/packages/openssl.htm
http://gnuwin32.sourceforge.net/packages/openssl.htm
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Enable SSL with “cert.pem” 
On the Parallels Client Gateway page, enable secure sockets layer (SSL) and click “…” to browse for the .pem 
file. 

Click “Apply” to apply the new settings. Your browser may not support display of this image. 

Parallels Clients do not trust the Issuer Certificate Authority (Optional) 

This step is needed; Parallels Clients do not trust the Issuer Certificate Authority, as they are not aware of 
it. Therefore, you need to extract the certificate out of the Certificate Authority and assign it to the 
Parallels RAS Clients. 

1 Using the certificate snap-in, find the certificate of the issuer from the certificates console. (Issuer certificate is 
the certificate of the Certificate Authority that issued the certificate.) 

2 Right-click on the issuer certificate, then click All tasks > Export. 

3 Choose “No” for “do not export the private key,” as we only need the certificate. 

4 As a format, choose Base-64 encoded X.509 (.CER). 
5 Specify the file name that you want to export and save the certificate as. 
6 Click “Finish.” 
7 Open the exported certificate with an editor such as Notepad or WordPad, and copy the contents 
to the clipboard. 

Parallels Client Side 
1. On the client’s side, under “C:\Program Files\Parallels\RAS Client\” there should be a file called

trusted.pem. This file contains the certificates of the common trusted authorities.

2. Paste the content of the exported certificate (attached to the list of the other certificates).

This will add the certificate of the issuer with the list of trusted authorities on the client side, and one 
would be able to connect over SSL with a certificate issued from an organization’s Certificate Authority. 
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Publishing Agents 

In This Chapter: 
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Secondary Publishing Agents .................................................................................... 101 
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Parallels RAS Publishing Agent provides load balancing of published applications and desktops. A RAS 
Publishing Agent is automatically installed on a server on which you install Parallels RAS and is designated 
as the master Publishing Agent. Each site must have a master Parallels RAS Publishing Agent but can have 
secondary agents added to it. The purpose of secondary agents is to ensure that users do not experience 
any interruption of the service due to a possible failure of the master Parallels RAS Publishing Agent. This 
chapter describes how to add Parallels RAS Publishing Agents to a site and how to configure them. 
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To ensure users do not experience an interruption of the service due to a failure of the master Parallels 
RAS Publishing Agent, one or more secondary publishing agents can be added to a site. 

With one or more secondary agents installed, the runtime data is replicated on each agent, so if any 
service fails, the downtime is reduced to a minimum. In addition, any active Parallels RAS Publishing 
Agent will be used for authentication purposes with both the AD and any second-level 
authentication provider used. 

The master Parallels RAS Publishing Agent performs the same tasks as secondary publishing agents but 
has additional responsibilities. It manages certain processes that have to be managed by a single 
publishing agent. 
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As a demonstration of how load distribution between multiple publishing agents works, consider the 
following example: 

• Suppose we have two publishing agents: PA1 (master) and PA2
(secondary).

• Suppose we also have 10 RD Session Hosts: TS1, TS2 ... TS10.

The resulting load will be distributed as follows: 

• TS1, TS2 ... TS4 will use PA1 as their preferred publishing agent.
• TS5, TS6 ... TS10 will use PA2 as their preferred publishing agent.
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High Availability Load Balancer HALB 
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High Availability Load Balancer (HALB) 
Before you can configure the HALB from the Parallels RAS Console, you first have to import an appliance 
with either of the following hypervisor platforms: VirtualBox or VMware. An appliance is a preconfigured 
virtual machine (including the operating system and other relevant settings). 

 
 

For VirtualBox or VMware, this appliance should be imported with either the OVA or a zipped VMDK 
appliance file obtained from the Parallels website. 

 
 

If deployed via the OVA file, the VM is applied with machine specifications already configured. 

Alternatively, deployment via the VMDK file deploys the VM without preconfigured specifications. The 
minimum specifications for this VM are outlined below: 

▪ 4vCPU 
▪ 4 GB RAM (otherwise SSL offload) 

▪ 1 network card 
 

For Microsoft Hyper-V, this appliance should be imported with the VDH file obtained from the 
Parallels website. 

 
 

Once confirmed, proceed with the two-stage setup process: HALB appliance installation and 
configuration, and adding a HALB appliance from Parallels RAS. 

http://www.parallels.com/ras/download-links/
http://www.2x.com/ras/downloadlinks/
http://www.2x.com/ras/downloadlinks/
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HALB Appliance Installation and Configuration 
The HALB appliance should be imported on a hypervisor running on a machine within the same local 
network as Parallels RAS. Import the HALB appliance on a supported hypervisor according to the 
procedure described below. 

Download the required HALB package, i.e. either the OVA, VMDK, or VDH file from the Parallels 
website. You will need to unzip the VMDK file, if required. Then simply import either the VMDK, OVA, 
or VDH file from the virtualization platform’s management console. When this is done, boot up the 
new appliance. 

Figure 62 – HALB Static IP Configuration Console 

If necessary, adjust the network settings and click “Apply” to continue. 

http://www.2x.com/ras/downloadlinks/
http://www.2x.com/ras/downloadlinks/
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Figure 63 – HALB Information Configuration Console 

The Configuration Console is displayed and the HALB appliance is ready to be added to a Parallels RAS 
farm. 
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Adding a HALB Appliance on Parallels RAS 
After the Parallels HALB appliance installation, the appliance has to be configured on a Parallels RAS farm. 

Configure the Parallels HALB appliance according to the procedure below: 

1. Log in to the Parallels RAS Console.

Figure 64 – Farm HALB Interface 

2. Go to Farm > HALB.
3. Enable the “HALB” checkbox.
4. Enter the Virtual IP (shared IP) in the first field. This is the IP address that the clients will connect

to. This will also be the floating IP used by the HALB appliances.
5. Enter the appropriate network mask.
6. For load balancing normal gateway connections, enable the “LB Gateway Payload” checkbox and

click “Configure.”
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Figure 65 – HALB Gateways Payload Settings 

7. From the HALB Configuration window, select the gateways that the Parallels RAS will load balance
on using the HALB appliances and click “Ok.”

8. Next, for load balancing SSL connections, enable the “LB SSL Payload” checkbox and click “Configure.”
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Figure 66 – HALB Gateways SSL Payload Settings 

9. The mode selected in the “Mode” dropdown box specifies where the SSL decryption process is
performed. By default, the SSL connections are tunneled directly to the gateways (referred to as
pass-through) where the SSL decryption process is performed.

10. To set the SSL decryption process to be performed on the HALB appliance, select “SSL Offloading”
mode and click “Configure.” This mode requires an SSL certificate installed on configured HALB
appliances.
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Figure 67 – HALB SSL Settings 

From the window illustrated in Figure 67, you may upload an SSL certificate to the HALB appliance for 
SSL offloading. This can be either a self-signed certificate or a certificate obtained from a registered 
Certificate Authority. 

▪ Optional: Tick the option “Allow only strong ciphers” to only allow the usage of certificates using
strong encryption algorithms.

▪ Select the “Accepted SSL Version” from the options available in the dropdown.

▪ Click on “Generate new certificate…” and enter the required details.

Alternatively, set up a certificate from a trusted authority according to the instructions below. 

▪ Click on “Generate certificate request…”
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Figure 68 – HALB Generate SSL Certificate 

▪ Fill in the details and click “Save” to bring up the certificate request window.

Figure 69 – HALB Generate Certificate Request 

▪ Click “Copy” to copy the request. This certificate request should be sent to a Certificate Authority.

▪ Once you receive the SSL certificate from the Certificate Authority, click “Import public key,” browse for the
certificate file containing the public key, and click Open.

▪ Click “Ok” to save the settings.
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Figure 70 – HALB Devices Interface 

Upon completion, proceed to add all the HALB appliances that will be managed by this farm. Click the "+" 
icon shown in Figure 70 to bring up the “Add HALB Devices” window. 

Figure 71 – HALB Devices 

Parallels RAS will detect Parallels HALB appliances over the network and display them here as a list. 
Selecting detected HALB appliances from this list is the preferred method for adding new appliances. If for 
some reason the appliance cannot be detected, you can also add the appliance manually by specifying the 
appliance IP in the “IP Address” field. Click “OK” to apply the configuration. 

After the “OK” button is clicked, the appliance is initialized and added to the list. 
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Figure 72 – HALB Configured 

Finally, click “Apply” for the configuration to be applied to all added HALB appliances. 
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Auditing 

 

Figure 73 – Farm Settings: Auditing 

The “Settings” in the farm allows the Auditing, Global Logging, URL Redirection, and Client Settings to 
be configured. 

 
 

Auditing can be enabled to capture Date & Time, user@domain, Action, Application ID, Application, Server 
Name, Session ID, and PID information. 
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Global Logging 
 

Figure 74 – Farm Setting: Global Logging 
 
 

Global Logging can be enabled to track various data communications between servers. It creates a .zip file 
to a location set by the administrator. 
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Redirection 
 

Figure 75 – Farm Settings: URL Redirection 

URL Redirection creates an exception to URL redirection and will open the URL using the RD Session Host 
browser. 
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Client Settings 

Figure 76 – Farm Settings: Client Settings 

Using the Client Settings tab under the Farm Settings section, you can specify which resolution should 
be used when the resources are displayed as icons within the Parallels Client. 
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Load Balancing 

 

Figure 77 – Load Balancing 

Load Balancer is designed to balance RDS and VDI host connections made from Parallels Clients. 
Resource-based and round-robin load balancing methods are both available out of the box. Both 
methods are explained in the following subsections. Load-balancing options can be configured from the 
Load Balancing category in the Parallels RAS Console. 
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Resource Based 
Distributes sessions to servers depending on how busy the servers are. Therefore, a new incoming session 
is always redirected to the least-busy server. 

 

Counters 
Resource-based load balancing uses the following counters to determine if a server is busier than the 
other(s) and vice versa: 

• User sessions – Redirect users to a server with the least number of sessions. 
• Memory – Redirect users to the server with the best free/used RAM ratio. 
• CPU – Redirect users to the server with the best free/used CPU time ratio. 

 
 

When all of the counters are enabled, the Parallels RAS Load Balancer adds the counter ratios together 
and redirects the session to the server with the most favorable combined ratio. 

 
 
 

Round-Robin Load Balancing 
Round-robin load balancing redirects sessions in sequential order. For example, with two RDS servers in 
the farm, the first session is redirected to server 1, the second session is redirected to server 2, and the 
third session is redirected to server 1 again. 
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Session Options 
• Reconnect to disconnected sessions – Enable this option to redirect incoming user sessions to 

a previously disconnected session owned by the same user. 

• Reconnect sessions using client’s IP address only – When reconnecting to a disconnected session, 
the Parallels RAS will match the user name requesting reconnection with the user name of the 
disconnected session to match the sessions. With this option enabled, Parallels RAS will determine 
which disconnected session to reconnect to by matching the source IP address. 

• Limit each user to one session per desktop – Enable this option to ensure that the same user 
does not open multiple sessions. Please note that for this option to work, your RD Session Hosts 
must also be configured to restrict each user to a single session. In Windows Server 2008, you 
need to enable the "Restrict each user to a single session" option in the Remote Desktop Session 
Host Configuration. In Windows Server 2012 R2, it's the "Restrict Remote Desktop Services users 
to a single Remote Desktop Services session" option in Local Group Policy > Remote Desktop 
Services > Remote Desktop Session Host > Connections. 

• Disable Microsoft RD Connection Broker – If this option is enabled, the Microsoft RD Connection 
Broker will not interfere with the Parallels RAS brokering done by the Parallels RAS Publishing Agent 
if it is installed. Please note that this option will only work with Windows Server 2012 and above. 
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Advanced Settings 
 
 
 

Figure 78 – Load Balance Advanced Settings 

The Advanced Load Balancer Settings can be used to test connections from the Publishing Agent to the RDS 
server, and thus prevent connections being sent to it if it’s not responding.  These times may be adjusted 
for latency on the network. 

 
 

 
Figure 79 – Load Balance Processes 

A process can be excluded so it isn’t counted against the total CPU % being utilized. 
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Application Publishing 
Publishing from Parallels RAS is one of the fundamental uses of the system. Parallels RAS can publish the 
following: 

▪ Applications 
▪ Desktops 

▪ Microsoft App-V applications 

▪ Turbo.net applications 

▪ Web applications 
▪ Documents 

▪ Folders on the file system 
 
 

To publish applications, select the “Publishing” icon from the systems menu. This will show what 
applications have already been published. If the application has yet to be published, select the 
“Application” icon from the console’s top menu. 
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Figure 80 – Publishing an Application, Step 1 
The first step is to choose what you would like to publish, as shown above. 
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Figure 81 – Publishing an Application, Step 2 
 
 

After you have selected what you would like to publish, you will be asked to select from where you would 
like to publish the application. Applications can be published from RD Session Hosts, Virtual Guest, and 
Remote PCs. 



Parallels RAS Training Manual    
128 

Publishing 
 

 

 

 
Figure 82 – Publishing an Application, Step 3 
 

Next, choose the type of application to be published. 
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Figure 83 – Publishing an Application, Step 4 
 
 

When Single Application is chosen first, the server(s) must be selected to publish the application. If the “All 
Servers in Farm” option is chosen, then the application must be installed on all the servers in the farm. A 
server group or individual servers can be selected.
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Figure 84 – Application Selection 
 
 

Once a server (or servers) has been selected, choose the target folder and executable file of the 
application to be published by selecting them with your cursor, then clicking “Open.” 
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Figure 85 – Adding Users to Filtering 

Next, the application can be filtered to determine which users can access the application. There are several 
methods for filtering: 

▪ User 
▪ Client 

▪ IP Address 

▪ MAC 
 
 

Figure 86 – Users Added to the Filtered Application 
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User filtering allows for the filtering of users by either Workgroup or LDAP (Active Directory). 
 

 

 
Figure 87 – Filtering by Client 

Client filtering allows for filtering by computer hostname. 
 
 
 
 

 
Figure 88 – Filtering by IP Address 

IP address filtering allows for filtering by a computer IP address. 
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Figure 89 – Filtering by MAC Address 

MAC filtering allows for filtering by a computer MAC address. 
 
 

Note: Without filtering, the application is available for all users, IPs, etc. 
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Figure 90 – Application Filtering Configured 

Click “Apply” after the filtering selection is completed. 
 
 
 

 

Figure 91 – Published Applications 
 

Figure 92 – Published Applications Shown on the Client Machine 

Published applications will appear in the Published Resources tab and in the Parallels Client after clicking 
the “Apply” button. 
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Figure 93 – Published Application’s Details 

The configuration for published applications can be changed by selecting the “Published Resource” 
option. Then select the tab that corresponds with the change that needs to be made. 
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Folders and Application Grouping 
 

Figure 94 – Adding a Folder Installation Wizard 
 
 

A folder can be created to place documents or applications in for organization. First, select the “Folder” 
icon from the console’s top menu. Then, enter a folder name and description (optional). The icon for the 
folder can be changed from the default one, which is shown in the picture above. 
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Next, a filter can be applied to control access to the folder. 
 

 

 
Figure 95 – Published Folder Filtering Options 

Published folders will appear in published resources and in the Parallels Client after clicking “Apply.” 
 

 
 

Figure 96 – Published Folder 
 

Figure 97 – Published Folder on the Client Machine 
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Desktop Publishing 
Parallels RAS can publish full RD Session Host, Virtual, and Remote PC desktops. To publish a desktop, 
select the “Desktop” icon from the console top menu. Then select the type of desktop to be published. 

 
 

Figure 98 – Desktop Publishing Installation 

The RD Session Host, Virtual, or Remote PC Desktop must be selected from the server, guest, or PC 
from which they will be published. 
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Figure 99 – RDS Desktop 
 

 
Figure 100 – Virtual Desktop 
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Figure 101 – Remote Desktop 
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Figure 102 – Published Desktop Filtering 
 
 

Filtering can be accessed by selecting the published application and then selecting the Filtering tab from 
the top. To add a user, click on the “+” icon on the top left-hand side and choose the user, as shown in 
Figure 102. 
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Figure 103 – Published Desktop 
 

Figure 104 – Published Desktop from the Client’s Machine 
 
 

Published desktops will appear in the Published Resources list and in the Parallels Client after clicking “Apply.” 
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Predefined Application Publishing 
Predefined applications can be published by selecting the “Predefined Application” icon from the console’s 
top menu. After this, select the application or applications to be published, and click “Ok.” 

 
 
 

 
Figure 105 – Applications on the System that Can Be Published 

Published items will appear in the Published Resources tab and in the Parallels Client after clicking “Apply.”
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Figure 106 – Published Applications on the Client's Machine 
 
 
 
 
 
 

 
Figure 107 – Published Applications 
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Document Publishing 

Figure 108 – Selecting the Type of Server to Publish From 

To publish a document, select the “Document” icon from the console’s top menu. Then, select the location 
from which the document should be published. 
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Figure 109 – Selecting the Document Type 

Select the document type. 
 
 

Figure 110 – RDS Desktop 
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Figure 111 – Virtual Desktop 
 

 
Figure 112 – Remote PC 

Depending on where the document is to be published from, a RD Session Host, Virtual Desktop, or 
Remote PC needs to be selected and location chosen using the “…” button next to “Target.” 
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Figure 113 – Filtering Document Users 

The document can be filtered in the same way as other published items, as shown in Figure 113. 

Published documents will appear in the Published Resources tab and in the Parallels Client after clicking 
“Apply.” 

 

 

Figure 114 – Published Document 



Publishing 

Parallels RAS Training Manual    
149 

 

 

 
 
 

 
 

Figure 115 – Published Document on the Client's Machine 
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Web Application Publishing 
 

As of Parallels RAS 15, web applications can also be published. A perfect example of a web application 
that can be published is a company’s internal intranet. As intranet is only accessible when connected to 
the company’s private network, a problem will arise when trying to access the company’s intranet from 
home or abroad. By publishing the web application using Parallels RAS, this issue is resolved. 

 

 

Figure 116 – Type of Publishing Selection 
 
 

1. Open the publishing wizard and select the “Web application” option. 
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Figure 117 – Selecting the Type of Server to Publish From 

The next step is to select the server from which you would like to publish the web application. Select 
the appropriate server and click “Next” to continue. 
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Figure 118 – Servers to Publish From 

If you have more than one server configured, Parallels RAS will prompt you to either use all the servers 
in the site, select server groups, or even to select individual servers as shown in Figure 118. If you only 
have one server configured, this step is skipped. 
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Figure 119 – Web Application Configuration RD Session Host 

In the case of RD Session Hosts, you will need to abide by the following steps: 
 
 

1. Enter the name and description of the web application in the “Name” and “Description” text boxes 
respectively. 

2. In the “Run” dropdown list, select whether the web application should run in either normal 
window, maximized, or minimized. 

3. Enter the web application’s URL in the “URL” text box. 

4. Tick the “Force to use Internet Explorer” checkbox if you would like the client to use Internet 
Explorer instead of the default browser on their device. 

5. Click “Finish” to publish the web application. 
` 
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Figure 120 – Web Application Configuration: Virtual Guest 
 
 

In the case of Virtual Guests, please abide by the following steps: 
 
 

1. Enter the name and description of the web application in the “Name” and “Description” text boxes. 

2. In the “Run” dropdown list, select whether the web application should run in either normal 
window, maximized, or minimized. 

3. Enter the web applications URL in the “URL” textbox. 
4. Tick the “Force to use Internet Explorer” checkbox if you would like the client to use Internet 

Explorer instead of the default browser on their device. 

5. Select the type of guest you would like to connect to by choosing from the “Connect to” dropdown 
list. 

6. Select the pool you would like to publish the web application from by choosing one of the options 
in the “from Pool” dropdown list. 

7. You may also opt to enable a persistent connection by checking the “Persistent” checkbox. 

8. Click “Finish” to publish the web application. 
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Figure 121 – Web Application Configuration: Remote PC 
 
 

For Remote PCs, please abide by the following steps: 
 
 

1. Enter the name and description of the web application in the “Name” and “Description” text boxes. 

2. In the “Run” dropdown list, select whether the web application should run in either normal 
window, maximized, or minimized. 

3. Enter the web applications URL in the “URL” text box. 

4. Tick the “Force to use Internet Explorer” checkbox if you would like the client to use Internet 
Explorer instead of the default browser on their device. 

5. Enter the Remote PC IP address in the “Remote PC” textbox. Alternatively, you may browse 
the available remote PCs by clicking on the “…” button. 

6. Click “Finish” to publish the web application. 
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Folder on the File System Publishing 
As of Parallels RAS 15, a folder on the file system publishing function has been introduced. This is done by 
using a UNC path as shown in the following steps. 

 

Figure 122 – Type of Publishing Selection 

Open the publishing wizard and select the “Folder on the file system” option. 
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Figure 123 – Selecting the Type of Server to Publish From 

The next step is to select the server from which you would like to publish the folder on the file system. Select the 
appropriate server and click “Next” to continue. 
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Figure 124 – Server to Publish From 

If you have more than one server configured, Parallels RAS will prompt you to choose between using all 
the servers in the site, select server groups, or even to select individual servers as shown in Figure 124. 

 
 

If you only have one server configured, skip this step. 
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Figure 125 – Configuring the UNC Folder RD Session Hosts 
 
 

For RD Session Hosts, please abide by the following steps: 
 
 

1. Enter the UNC path. Alternatively, you can click on the “…” button to manually select the path from 
a browser which will be shown in another dialogue box. 

2. In the “Run” dropdown list, select whether the folder should run in a normal window, maximized, or 
minimized. 

3. Give a name to the folder you are going to publish by typing in the “Name” field. You can also 
opt to add a description in the “Description” textbox beneath. 
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Figure 126 – Configuring the UNC Folder Virtual Guest 

For Virtual Guests, please abide by the following steps: 

1. Enter the UNC path. Alternatively, you can click on the “…” button to select the path from a browser, 
which is shown in another dialogue box. 

2. In the “Run” dropdown list, select whether the folder should run in either normal 
window, maximized, or minimized. 

3. Give a name to the folder you are going to publish in the “Name” textbox. You can also opt to 
add a description in the “Description” textbox beneath. 

4. Select the type of guest you would like to connect to by choosing from the “Connect to” dropdown list. 

5. Select the pool you would like to publish the web application from by choosing one of the options 
in the “from Pool” dropdown list. 

6. You may also opt to enable a persistent connection by checking the “Persistent” checkbox. 

7. Click “Finish” to publish the folder. 
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Figure 127 – Configuring the UNC Folder Remote PC 

For Remote PCs, please abide by the following steps: 

1) Enter the UNC path. Alternatively, you can click on the “…” button to select the path from a 
browser, which will be shown in another dialog box. 

2) In the “Run” dropdown list, select whether the folder should run in either a normal window, 
maximized, or minimized. 

3) Give a name to the folder you are going to publish in the “Name” textbox. You can also opt to 
add a description in the “Description” textbox beneath. 

4) Enter the Remote PC IP address in the “Remote PC” textbox. Alternatively, you may browse the 
available remote PCs by clicking the “…” button. 

5) Click “Finish” to publish the folder. 
 

Figure 128 – Published File on System 
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Publishing Containerized Applications 
Turbo.net is a web-based container platform that runs applications on a Windows desktop with no 
installation required. Parallels RAS provides you with the ability to publish applications hosted by Turbo.net 
and make them available to Parallels RAS users, just like regular applications hosted by RD Session Host 
servers. 

The ability to publish container-based applications allows Parallels RAS administrators to greatly reduce 
TtV (time to value) and minimize investment and development resources. The integration of the solution 
provided by Turbo.net gives you the following immediate benefits: 

• Instant access to an online application repository with hundreds of applications available, including: 
o Most web browsers (Google Chrome, Firefox, Opera, etc.) 
o Most application runtimes (JRE and others) 
o Most add-ons (Flash, etc.) 
o Open-source applications like LibreOffice, VLC Player, etc. 
o Administrative tools like WinSCP, Putty, etc. 

• Instant provisioning of all these applications in any combination possible (i.e. a particular version of 
Google Chrome with a specific Java runtime and Flash) to all endpoints regardless of the platform 
and version (supports anything from Windows XP to Windows Server 2016). 

For more information about Turbo.net, visit turbo.net 
 
 

Licensing and supported Turbo.net repositories: 

• Parallels RAS uses the free edition of Turbo.net, so no subscription is required. 
• Parallels RAS supports application publishing from the public Turbo.net repository only. Private 

repositories are not supported at this time. 

http://www.turbo.net/
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Managing Published Items 
Published items can be managed from the options menu of the console when “Publishing” has been 
selected from the systems menu. Applications can be added, deleted, moved up, moved down, disabled, 
sorted, or even searched for using the “Find” option. These options are self-explanatory, but it’s worth 
noting that “Sort” will order published items in alphabetical order. 

 
 
 

 
Figure 129 – Managing Published Items Features 

 
 

Troubleshooting Tip: Placing the published items in a specific order may be beneficial to admins so that 
can refer to the icons without looking directly at the Parallels Client. 
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Parallels Universal Printing 
When using Parallels RAS, the printing process is greatly simplified through the Parallels Universal Printer 
function. It is automatically installed when you install the agents for RD Session Host, VDI Guest, and 
Remote PC. 

Parallels Universal Printing will solve most printer driver problems. If the client is using a printer where the 
server does not have a suitable printer driver, the normal printing redirection will not work. However, you 
will not need to install a specific printer driver on the server when you are using Parallels Universal 
Printing. The Parallels Universal Printer drivers are available in 32- and 64-bit format. 

Parallels Universal Printer Support was added to HTML5 Gateway and the Chrome app in Version 14. 

As of Parallels RAS version 10.1, you can redirect multiple printers at the same time, as opposed to the 
previous versions where only one printer (Parallels Universal Printer) was available on each RD Session 
Host. 

 

Figure 130 – Printer Naming Variables 

The administrator can choose the format of each printer name by editing the “Printer Rename Pattern” 
textbox. You can also choose to continue to work in legacy mode by choosing <Parallels Universal Printer> 
as the printer rename pattern. In this case, only the first printer redirected by the client is utilized. 

 
 

You can use any of the following variables in the “Printer Rename Pattern” textbox: 
 
 

%PRINTERNAME% Client-side printer name 

%USERNAME% User name connected to the server 

%SESSIONID% Session ID of the active session 

<Parallels Universal Printer> Legacy mode (only one printer for all users) 
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Choosing <DEFAULT> means that the default printer pattern is used. The 

default pattern is %PRINTERNAME% for %USERNAME% by Parallels. 

 

Figure 131 – Available Printers 

Redirected printers are only accessible by administrators and the user who redirected the printer. 
Choosing <Parallels Universal Printer> means that only one printer will be shown on the server and is 
available for all users. 
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HTML5 Gateway and Chrome App Printing 
When printing via the HTML5 Gateway and the Chrome app, the user will see the Parallels Universal 
Printer option. Choose this print option and click “Print.” Once the user prints, the Parallels Universal 
Printers for HTML5 Gateway and Chrome will open the local printers installed on the device. 

 
 

Figure 132 – Printer Options 
 
 

To enable or disable the functionality of Parallels Universal Printing from each RD Session Host, VDI Guest, 
or Remote PC in the farm, select the RD Session Host(s), VDI Guest(s), or Remote PCs and click “Enable” 
from the Task dropdown menu. Click “Select All” to facilitate Parallels Universal Printing on every type. 
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Figure 133 – Universal Printing Interface 

To disable Universal Printing, select the RD Session Host, VDI Host, or Remote PC and click “Disable” 
from the Task dropdown menu. 
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Fonts Management 
 
 

Figure 134 – Fonts Management Interface 
 
 

To control the embedding of fonts within a print job, use the EMF Properties tab and check/uncheck 
“Embed Fonts.” By default, a number of fonts will already be excluded, since these are normally available 
on standard Windows platforms. If the client selects the “Enhanced Meta File” data format for Universal 
Printing, the fonts are embedded with the print job. 

 
 

To add a new font, click on the “Add” button from the Task menu and select the font to be added. To 
delete a font, select the font from the excluded list and click “Delete” from the Task menu. 

 
 

Note: Embedded fonts are deleted after a print job. 
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What Is Universal Scanning? 
Scanner redirection enables users who are connected to a remote desktop or who are accessing a 
published application to make a scan using the scanner that is connected to the client machine. 

 
 

Parallels Universal scanning uses TWAIN as well as WIA redirection; this allows any application using 
either technology hardware connected to the client device for scanning.  

 
 

 
 

With Parallels Universal Scanning, there is no need to install any scanner drivers on the server. Only one 
scanner is shown on the server regardless of the number of users and sessions currently in use on the RD 
Session Host. The Parallels Universal Scanning drivers come in 32- and 64-bit format. 

Note: The server feature “Desktop Experience” is required in order in enable both WIA and TWAIN scanning on 
RD Session Hosts. 
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Universal Scanning Options 
By default, the Parallels Universal Scanning driver is automatically installed with the RD Session Host, VDI 
Guest, and Remote PC agents. Therefore, upon adding a server to the farm, the Parallels Universal 
Scanning function is also installed. 

 
 

 
 

 

Figure 135 – Universal Scanning Interface (WIA) 

Note: The Parallels Universal Scanning driver is available in 32- and 64-bit format. Currently only 32-
bit applications are supported. 
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Configuring a Scanning Rename Pattern 
By default, Parallels RAS renames the scanners using the following pattern: 
%SCANNERNAME% for %USERNAME% by Parallels. Therefore, if a user named Samuel that has SCANNER1 
installed locally connects to a remote desktop or published application, his scanner is renamed to 
SCANNER1 for Samuel by Parallels. 

 
 

To change the pattern used to rename scanners, specify a new pattern in the “Scanner rename pattern” 
input field found in the Parallels RAS Console > Universal Scanning node. The variables available for 
renaming scanners are: 

▪ %SCANNERNAME% – Client-side scanner name 

▪ %USERNAME% – Username of the user connected to the server 

▪ %SESSIONID% – Session ID of the action session 
 
 

You can also configure a different scanner renaming pattern specifically for each server from the server 
properties. 

 
 

 
 

Enabling and Disabling Parallels Universal Scanning Support 
To enable or disable WIA or TWAIN Parallels Universal Scanning support from a particular server, follow 
the below process. 

 
 

Open the Parallels RAS console and open the Universal Scanning category in the navigation bar. Click the 
WIA or TWAIN tab. 

 
 

Highlight the name of the server you would like to modify. Click “Enable” to enable Parallels Universal 
Scanning support or “Disable” to disable it from the Tasks dropdown menu. 

Note: Redirected scanners are only accessible by administrators and the user who redirected the scanner. 
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Adding Scanning Applications 
TWAIN applications that will use the Universal Scanning feature have to be added from the TWAIN tab by 
selecting the “TWAIN Applications…” button so they can use the TWAIN driver, making it easier for the 
administrator to set them up. Follow the process described below to add an application to the list of 
scanning applications: 

 

 

 
Figure 136 – Universal Scanning Interface (TWAIN) 

Open the Parallels RAS Console and open the Universal Scanning category. Click the TWAIN tab. Click on 
the “TWAIN Applications…” button and click “Add.” From here, browse to the application executable and 
click “Open.” 

 

Configuring Scanning Applications 
Note: Some applications might use different or multiple executables. Make sure that all used executables are added 
to the list of scanning applications. 

 

Deleting a Scanning Application 
To delete a scanning application from the list, highlight the application name and click “Delete” from the 
Tasks dropdown menu. 

Note: By deleting an application from the list of scanning applications, the installation of the application will 
not be affected. 
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Quick Keypads 
The Quick Keypad category in the Parallels RAS Console allows you to define custom keys to perform 
common actions in published applications running on mobile devices. Custom keys appear above the 
standard keyboard in iOS and Android and can be tapped just like any other key on the virtual keyboard. 

This feature is designed for users who run published applications on a phone or a tablet. When a particular 
software requires repeated selection of certain menu or toolbar items, using custom keys can significantly 
improve the user experience. For example, let's say a user has some data entry task which requires them 
to press File > New and File > Save menu items over and over again. If you define two custom keys to 
perform these actions, the user will see them above the standard keyboard in iOS or Android. Instead of 
tapping the application's native menu items (which can be cumbersome), they can tap these keys, which is 
much easier and quicker. 

To define custom keys, select the “Quick Keypad” category in the Parallels RAS Console. The Quick 
Keypads view in the right pane allows you to create a Quick Keypad template. A template is created for a 
specific application (or a group of applications with the identical UI design) and contains shortcuts to 
perform common actions in an application. Once a template is created, you assign it to a published 
application or a group of applications, so each application (or a group) has its own Quick Keypad. 
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Authentication 
Parallels RAS Connection Manager category allows administrators to set a requirement for all users 
to authenticate connections to Parallels RAS. All trusted domains or workgroups will be allowed to 
make connections to Parallels RAS automatically. 

 
 
 
 

 
Figure 137 – Connection Authentication Settings 

 
 

An individual domain or workgroup can be selected from a list by selecting the “…” button, which will 
only allow that domain or workgroup to connect to Parallels RAS. 
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Figure 138 – Domain Selection 

If the domain is specified, “Use client domain if specified” can be unchecked and it will automatically 
populate that field in the Parallels Client. To clear all cached session IDs, click “Clear cached session IDs.” 

 
 

 
 

In order to specify authentication with a workstation, you must enter [workgroup_name] / 
[machine_name]. Therefore, if you would like to authenticate against a machine named “SERVER1” that is 
a member of the workgroup named “WORKGROUP,” you would have to enter: WORKGROUP/SERVER1 in 
the domain field. 

NOTE: To authenticate a workstation not joined to a domain, a local account can be used. In order to avoid user 
filtering problems, it is suggested to use the NetBIOS name instead of the FQDN in the domain field. 
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Settings 

Figure 139 – Connection Settings 
 
 

The Settings tab in the Connection category allows you to configure the following remote session 
options: 

• Declare session idle after – This option affects reporting statistics; a session is declared idle after 
the amount of time specified without any activity. 

• Automatically logoff RAS idle session after – Specifies the time period after which an idle session 
(a user Parallels RAS connection) should be logged off. Once the session is logged off, the user is 
disconnected from Parallels RAS and is presented with the “Connections” dialog in Parallels Client 
as a way to notify them that they were logged off. They can use the dialog to log back on if desired. 

• Cached Session Timeout – Specify the amount of time that a session is cached for. (A higher 
amount of time reduces AD transactions.) 

• Clear cached session IDs – Clears all cached session information. 
• FIPS 140-2 encryption – Enable or disable the FIPS 140-2 encryption. 
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Second-Level Authentication 

Figure 140 – Connection Second-Level Authentication 

Parallels RAS allows you to use multifactor authentication for access control by configuring a second-
level authentication. When second-level authentication is used, users will have to authenticate through 
two successive stages to get the application list. While the first-level authentication will always use 
native authentication (Active Directory / LDAP), the second level can use one of the following: 

• Azure MFA server (RADIUS) 
• Duo (RADIUS) 
• FortiAuthenticator (RADIUS) 
• TekRadius 
• RADIUS 
• SafeNet 
• Deepnet 

The second level of authentication is more secure; instead of using a standard username and 
password, it uses a static username and a one-time password generated by a token. 
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Allowed Devices 

 
Figure 141 – Connection Allowed Devices 

You can specify a minimum requirement for the Parallels Client type and version number in order for it to 
connect to the Parallels RAS farm or to list published resources. 
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Configuring Client Policies 
 
 

Figure 142 – Policies Interface 
 
 

Client Policies are accessible through the Polices category. Client Policies provide a way to restrict 
configuration of the Connection Properties and Options of Parallels Clients on Windows Desktop 
OSes (including Windows CE and XP Embedded). 
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Figure 143 – Client Policy Properties 

Users or groups can be added to a policy, which pushes different Parallels Client settings and options to the 
users depending on the policy settings. A device license is not needed to use these options. 
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What Is the Client Manager? 
With Client Manager, you can manage Windows clients, shadow clients, and replace the desktop shell 
through the Parallels Desktop shell replacement. 

 
 

Client Manager supports Windows 7, 8, 8.1, and 10. These editions must be able to accept an inbound 
RDP connection. 
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Devices 
 

Figure 144 – Client Manager Interface 

From the Client Manager category in the Parallels RAS Console, you can view all clients connected to the 
system. You can manage, shadow, and deploy the Parallels Desktop Shell replacement to Windows 
desktops only. 

Once the Windows device is in management mode, you will be able power on, power off, reboot, log off, 
and shadow the desktop. 

 

Figure 145 – Managed Windows Client 
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Windows Device Groups 
With Windows Device Groups, you now have the ability to group Windows devices into manageable 
groups. This gives the administrator the ability to create managed groups to control all devices within 
the group under one setting. 

 
 

 

Figure 146 – Device Groups: Main Settings 
 
 

 

Figure 147 – Device Groups: OS Settings 
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Managing Windows Device Groups 
Convert Windows devices running Windows 7 up to Windows 10 into thin clients using the Parallels Client 
for Windows. 

 

Install and Configure 
 
 
 

Figure 148 – RDP Client Adding a New Connection 

Download the Parallels Client for Windows: 
parallels.com/products/ras/download/links/ 

http://www.parallels.com/eu/products/ras/download/links/
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Figure 149 – Parallels Client Connection Properties 

Upon completion, run the Parallels Client and configure a new Parallels RAS connection by following the 
steps below: 

1. Click “File.” 
2. Click “Add New Connection.” 
3. Select “Parallels RAS” and click “Ok.” 
4. Next, configure the connection properties below: 

▪ Primary Connection – Specify the Parallels RAS FQDN or IP. 

▪ User Credentials – Enter Username, password, and domain. 

5. Click “Ok” to create the new connection. 
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Windows Device Enrolment 
Windows devices can be set to be automatically managed by your farm or require that the admin approves 
them first. 

 
 

 

Figure 150 – Client Manager: Devices 

Approve a device to be managed by Parallels RAS from the Parallels RAS Console by following the next 
steps: 

1. Go to Client Manager > Devices. 

2. Click a device. 
3. Click “Tasks.” 

4. Click “Manage Device.” 
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Figure 151 – Client Manager: Pairing Devices 

The device state will change to “Pair pending” until the device reconnects. 
 
 

Once the Parallels Client reconnects, the enrollment process is complete and the device is managed by 
Parallels RAS. 

Alternatively, set Parallels RAS to automatically manage Windows devices: 
 
 
 

1. Go to “Client Manager.” 

2. Click “Options.” 

3. Enable “Automatically Manage Windows Devices.” 
 
 

Once managed, applications published by Parallels RAS become available on the Parallels Client as per 
Figure 151. The administrator can now check the state of the device and perform power control actions 
such as powering on, powering off, rebooting, and logging off. 

 
 

Note: Devices running older versions of the client cannot be managed and are marked as “Not Supported.” 
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Shadow a Windows Device 
Shadow a Windows device to gain access to the full desktop and controls published from Parallels RAS. 

 
 
 
 

Figure 152 – Shadowing a Windows Device 

Shadow a Windows device according to the steps below: 

1 Go to Client Manager > Devices. 

2 Select a device. 

3 Click “Shadow.” 
 
 

 
 

In addition, shadowing requires a direct connection between the machine from where the console is 
running and the device itself. 

Note: The Windows user will be prompted to allow the administrator to take control and can choose to deny 
access. This prompt can be deactivated by the administrator. 
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Desktop Replacement 
The “Replace desktop” option limits users from changing system settings or installing new applications. 
Replace the Windows desktop with the Parallels RDP Client to convert the Windows operating system into 
a thin client–like OS without replacing the operating system. In this case, the user can only deploy 
applications from the Parallels Client. 

 
 
 
 

Figure 153 – Replace Desktop 
 
 

To enable the “Replace Desktop” feature: 

1. Right-click the Windows device. 

2. Click “Properties.” 
3. Click “OS Settings.” 

4. Enable “Replace Desktop.” 

5. Click “OK.” 
 
 

Note: This feature requires an administrative password set to switch between user and admin mode on the 
Windows device. 
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Switching to Admin Mode 
 
 
 
 

Figure 154 – Switching to Admin Mode 
 
 

In User Mode, the user is limited to only use the applications provided by the administrator. To change 
system settings, switch the device to Administration Mode. 

 

Change to Admin Mode by right-clicking on the system tray icon, selecting “Switch to admin mode,” and 
providing the password configured. 
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The table below outlines the features available in Admin Mode and User Mode. 
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Configuring Local Applications Using the Parallels Client Desktop 
Replacement 
With the “Replace Desktop” option enabled, the administrator’s target should be to deploy remote 
applications or desktops and use the native OS to deploy the software needed to connect remotely. 
However, in some instances local applications may be needed. The administrator still has the ability to 
configure local applications to be shown within the Parallels Client Desktop Replacement. However, it is 
necessary to switch to Admin Mode prior. 

Publish a local application according to the following steps: 
 
 

1. Shadow the user’s session or use the user device station directly. 

2. Switch the Parallels Client Desktop Replacement to Admin Mode. 
3. Click File > “Add New Application…” 

 
Figure 155 – Adding Local Application Details 

4. Fill in the application information. 
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Figure 156 – Added Application on the Client Machine 
 
 

Applications added will be visible in the Application Launcher. 

Switch back to user mode once all the applications needed are configured. 
 
 

For a full list of Desktop Replacement features available per OS, visit: 

parallels.com/products/ras/features/client-management/ 

http://www.parallels.com/products/ras/features/client-management/
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Options 
Device Status and Color Coding 

 

Figure 157 – Client Manager: Color Management Options 

Devices that connect to Parallels RAS can have any of the following statuses: 

▪ Off – Device is switched off. 

▪ Booting – Device is booting. 

▪ Installing – Device is installing. 

▪ Connected – Device is connected. 

▪ Logged On – Devices is logged on to the system. 

▪ Restarting – Device is restarted. 

▪ Standalone – Device has previously connected to Parallels RAS but is not managed or isn’t a 
manageable device; therefore, it cannot be managed. 

▪ Needs Approval –Device needs approval to connect to Parallels RAS. 

▪ Deny – Device has been denied access to Parallels RAS. 

▪ Not Support – Device is not supported by Parallels RAS. 

▪ Error – Device is experiencing errors. 
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Scheduler 
The Scheduler allows the administrator to manage devices’ schedules. The administrator can pre-program 
actions to switch on, switch off, or reboot devices at a specific time of day. 

 

 
Figure 158 – Scheduler Properties 

 

Figure 159 – Scheduler Interface 
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Multiple Sites 

Figure 160 – Farm Info 

A Parallels RAS farm can have multiple sites. Each site consists of a publishing agent, a Secure Client 
Gateway or multiple gateways, and the agents installed on the RD Session Hosts, VDIs, and PCs. At least 
one server has to be dedicated for a site where the master publishing agent and gateway will be installed. 

 
 

Additional site requirements: 
 

▪ Must be on the same LAN or have a VPN connection to the remote secondary site. 

▪ Must be on the same domain or have a two-way trust between domains. 
 
 

The first default site added to the Parallels RAS farm is the Licensing Server, where the main Parallels 
RAS configuration database is stored. Every other additional site on the farm will have a synched copy 
of the configuration database. Once changes are applied to a particular site, the Licensing Server 
database is updated. 

Sites can be managed from the Farm node in the navigation tree available in the Farm category.  

 
 

Note: The Farm node is only available to administrators who have full permissions on the farm. 
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Adding a New Site to the Farm 
To add a site to the Parallels RAS farm, follow the process described below. 

Click the Farm node in the navigation tree and click the “+” button to launch the Add Site wizard. 
Alternatively, you can also select the “Add” option from the Tasks dropdown menu. In the first step of 
the wizard, specify a site name in the “Site” input field and specify the server IP or FQDN where the 
master publishing agent and gateway will be installed in the “Server” input field. 

 
 
 

 
Figure 161 – Add Site 
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Figure 162 – Checking New Site Settings 

In the second step of the wizard, Parallels RAS checks whether the Parallels Publishing Agent is installed 
on the site server. If not, click “Install” to proceed with the remote installation. 

 
 

In the “Installing Parallels Publishing Agent” dialog, highlight the server name on which the 
Parallels Publishing Agent is to be installed, as seen in Figure 163. 

 
 

Optional: Tick the “Override system credentials” option to specify and use different credentials to connect 
to the server and install the Parallels Agent. 
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Installing Parallels Publishing Agent Dialog Box 
 

Figure 163 – Installing Agent Site 
 
 

Click “Install” to install the publishing agent and gateway, and click “Done” once it has been successfully 
installed. 

 
 

In the last step of the Add Site wizard, click “Ok.” 
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Accessing Site Configuration 
Once a new site is created, you can access its configuration by running the Parallels RAS Console on the 
site server, or by switching to its configuration from the Parallels RAS Console as explained in the 
Switching Between Sites Configurations section. 

 
 

Note: When running the Parallels RAS Console, you will always be connected to the 
licensing server database, even if running it from a site server. Once changes are applied, configuration changes 
are replicated from the licensing server to the site servers. 
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Switching Between Site Configurations 
 

Figure 164 – Farm Sites 

From the Parallels RAS Console, you can only view the configuration of one site at a time. If you log in as 
a farm administrator, the configuration of the Licensing Server site will be loaded. If you log in with an 
administrator that has access to a specific site, the configuration of that particular site will be loaded. 

To switch between the configurations of different sites from the Parallels RAS console, follow the process 
below: 

Open the Farm category and click on the Farm node from the navigation tree to access the list of sites in 
the farm. 

Highlight the site you would like to configure, and from the Tasks dropdown menu select “Switch to this 
Site.” Alternatively, you can use the top bar and select the site you want to switch to from the Site drop 
down menu. 

 

 
Managing Sites 
Sites can be managed from the Farm node in the navigation tree available in the Farm category. From this 
section, you can change the farm name and also add or delete sites. 
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Replicating Site Settings to All Sites 
 

Category Section Options 

Farm VDI Hosts, Persistent Guests Auto Removal Timeout 

Farm Settings, Auditing All Settings 

Farm Settings, Global Logging Logging Settings 

Farm URL Redirection All Settings 

Load Balancing Load Balancing All Settings 

Publishing Advanced, Shortcuts All Settings 

Publishing Advanced, Extensions All Settings 

Publishing Advanced, Licensing All Settings 

Publishing Advanced, Display All Settings 

Publishing Filtering, User All Settings 

Publishing Filtering, Client All Settings 

Publishing Filtering, IP Address All Settings 

Publishing Filtering, MAC All Settings 

Universal Printing Universal Printing Printer Renaming 

Universal Printing Font Management All Settings 

Universal Scanning Scanning Applications All Settings 

Connection Authentication All Settings 

Connection Second-Level Authentication All Settings 

Connection Allowed Devices All Settings 

Reporting Reporting Engine Reporting Engine Type 

Reporting Engine-Specific Settings All Settings 

 
Any setting which is site dependent can be replicated on all other sites. Refer to the above table for more 
specific information about which settings can be replicated on other sites. 
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To replicate a specific setting to all other sites, tick the option “Replicate settings” highlighted in Figure 165. 
 

Figure 165 – Replicate Site Settings 
 

If an administrator has permissions to enable or disable the replication settings and makes a change 
to a specific setting, these new settings are replicated to all other sites. 

If an administrator has access to a particular site only and modifies the site settings which have been 
replicated, the replicated settings are overridden and the option “Replicate Settings” is automatically 
switched off. Therefore, such settings will no longer be replicated to other sites. 

 

 
Setting a Site as a Licensing Server 
If the Licensing Server fails or you would like to set a different site as a Licensing Server, click on the site’s 
name from the Farm node in the navigation tree. From the Tasks dropdown menu, select “Set Site as 
Licensing Server.” 
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Configuring Administrators 
The administration section allows administrators to grant permissions to user accounts or user groups, set 
up email accounts, set notifications, import/export backups, update software, and audit settings. 

 

 
Administration 

 

Figure 166 – Administrator Properties 
 
 

After installing Parallels RAS, an administrator account with full administrative capabilities is created for 
the user that performed the installation. Additional administrator accounts can be added with varying 
administrational rights. 

By selecting either “+” or “Add” from the Task Menu, an Active Directory dialog box will present itself, 
allowing you to add additional administrators. 

The administrative permissions can be set at this time by clicking the “Change Permissions” button. Full 
permissions and “All Sites” are the default setting. 
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Figure 167 – Full Site Permissions 
 
 

Site permissions can be set by deselecting “Full Permissions.” 
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Figure 168 – Site Permissions 

Each category of permissions has a detailed description of the permissions it can implement and can be 
set for all or specific sites. 
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Mailbox Setup 

Figure 169 – Mailbox Setup Interface 

After configuring the monitoring process on the SMTP server, the connection details should be configured 
to send emails once a monitoring counter is triggered. Below is a list of settings available to configure 
email notifications from the “Mailbox” tab: 

 

▪ Sender email address 

▪ SMTP server IP or FQDN 

▪ Disable or enable TLS/SSL encrypted communication 

▪ SMTP server credentials in case the SMTP server requires authentication
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Sending Email Invitations and Settings to Users 
 
 

 
Figure 170 – Send Invitations Interface 

Parallels RAS supports multiple platforms, ranging from desktop PCs and Mac computers to mobile 
devices and Chrome apps. The Invitation Email feature is designed to reduce the complexities 
involved in the installation and client rollout process. This feature allows the administrator to send 
client installation and auto-configuration instructions to end users from the central management 
console. 

 
 

Before proceeding, first confirm that you have correctly configured the Mailbox. 
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Send Invitation Email 
 
 

Figure 171 – Target Platform and Connection 

Navigate to Start > Invite Users and configure the options as below: 
 

• Select the target platform and connections to be sent out. 
Platforms available: 

▪ Windows 

▪ macOS 

▪ HTML5 

▪ iOS 

▪ Android 

▪ Chrome App 

▪ Linux 

• On the "Specify connection options" section, configure the options listed below: 
▪ Public Gateway IP – Choose the gateway (GW) domain name or IP. Please note that this can 

be the public IP in order to reach the system from a remote user. 

▪ Gateway Mode – Choose the gateway connection mode. Note that SSL modes require the 
GW to have SSL configured. 
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Default Invitation Email Template 
 

1. The Email section displays the message that will be sent to recipients. Choose to edit the 
text within this email or leave it as the default. Available variables include: 

 
%RECIPIENT% – Recipient user name 
%SENDER% – Administrator account which the email is sent from 
%INSTRUCTIONS% – Includes the automatic configuration process 
%MANUALINSTRUCTIONS% – Includes the manual configuration process 

 
2. Upon completion, click "Next" to send out the email to the recipients added, “Preview” to 

view how the email will be displayed to users, and “Default” to revert the email back to the 
original text. 
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Notifications  

To be notified when some counters exceed a certain amount, you will need to enable the notification  
settings in the options menu. You also have the option to run certain scripts when the notification is  
triggered.  

In the Notifications tab, you can set the notification event handlers and assign your desired parameter.  
You can set the option for "Rises above" or "Decreases below" the defined value.  

Figure 172 – Administration Notification Settings  

In Figure 172, an example of running notepad has been set but is disabled.  
  

You can choose any of the counters monitored by the Parallels Terminal Server Agent and set the  
appropriate number accordingly. For example, if you want to be notified when a RD Session Host is  
handling more than 45 sessions simultaneously or if the RD Session Host has more than 10  
disconnected sessions, simply tick the appropriate checkbox and configure the right amount.  
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Reporting 

Figure 173 – Administration Reporting Configuration 

Before you can generate reports from the Parallels RAS Console, MS SQL and the Parallels Reporting 
Service must be installed and configured. Please see Section 16 for reporting configuration. Once the 
Parallels RAS Reporting tool is configured, you can test your reporting server’s settings as well as maintain 
data retention. 

 

Tracking Settings 
 

Figure 174 – Tracking Settings 
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Settings Audit 

Figure 177 – Settings Audit 
 

From the Settings Audit tab in the Administration category, you can see all of the configuration changes 
done to Parallels RAS by all its administrators. 
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Administrator Chat 
As of Parallels RAS 15, a chat feature between administrators has been introduced to facilitate 
communication between multiple administrators using the console. An administrator may opt to either 
send a message to an individual administrator, or send a message to all logged-in administrators. 

 
 

Figure 178 – Accessing Administrator Chat 

To access the chat feature, click the arrow button next to the currently logged-on user’s email 
address, and click the “Chat…” option. 
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Figure 179 – Chat Dialogue Box 

As shown in Figure 183, the chat dialog box is divided into three sections. 

▪ Section 1 – The chat messages are displayed. 

The format of a sent message is as follows: 

sender@domain -> recipient@domain : Chat message 

The format of the message from the recipient is as follows: 

recipient@domain: Chat message 

 

▪ Section 2 – All logged-in administrators are shown. The message will be sent 
according to the selected administrator in this section. If the “All” option is selected, then the 
message will be sent to all the administrators currently logged in; alternatively, if 
“administrato2@marketing.local” is selected, then the message will only be sent to 
administrator2@marketing.local. 

 
 

▪ Section 3 – Write the message to be sent. Once the message is written, click “Send.” You can click 
on the “Clear All” button to wipe out all the chat history saved for all administrators. 

mailto:sender@domain.com
mailto:recipient@domain.com
mailto:recipient@domain.com
mailto:administrato2@marketing.local
mailto:administrator2@marketing.local
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Figure 180 – Administrator Chat 

 
 

Figure 180 shows an administrator chat with three administrators currently logged into Parallels RAS: 
 
 
 

Chat 1 – administrator@marketing.local perspective 

Chat 2 – administrator2@marketing.local perspective 

Chat 3 – matt@marketing.local perspective 

 

Chat 1 shows the messages being sent out by administrator@marketing.local. This administrator has sent 
three messages in all. The first two messages were sent directly to administrator2@marketing.local, while 
the last message was sent to all administrators. 

mailto:administrator@marketing.local
mailto:administrator2@marketing.local
mailto:matt@marketing.local
mailto:administrator@marketing.local
mailto:administrator2@marketing.local,
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Chat 2 shows the messages received by administrator@marketing. The first two messages are personally 
sent to administrator2@marketing.local and are only visible to the two corresponding administrators. The 
last message was sent to all administrators; the message is visible to all logged-on administrators. 

 
 

Chat 3 shows only one message, as there were no direct messages from other administrators to 
matt@marketing.local. The only message shown in the chat is the message sent out to all administrators 
by administrator@marketing.local. 

mailto:administrator2@marketing.local
mailto:matt@marketing.local
mailto:matt@marketing.local
mailto:administrator@marketing.local
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Information 
Local Information 

Figure 181 – Local Information 

The Local Information section provides administrators with the status of the services and agents on the 
server. 

 
The status is refreshed every minute. Click “Refresh” to manually refresh the content. 
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Site Information 

Figure 182 – Site Information 

The Site Information tab displays various information about the Parallels environment, such as: 
▪ Servers 

▪ Publishing Agents 

▪ Gateways 

▪ Sessions 

▪ Guests 

▪ Applications 
 

Server information shows the type, agent status, CPU utilization, memory utilization, active sessions, and 
disconnected sessions. 

Gateway information shows the OS type, Parallels version, gateway mode, allow only strong ciphers, 
gateway port number, SSL/TLS status and port number, broadcast service, active RDP sessions, and 
security mode. 

Session information shows the active session User ID, IP, protocol, state, and type. 

Guests information shows VDI guests’ OS, Parallels RAS version, service start time, and OS boot time. 

Application information shows what applications users have opened and the session number. 
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Software Requirements 
With version 14, Parallels introduced a built-in reporting tool. Parallels Reporting is a service that uses 
Microsoft SQL Server to supply 14 reports to administrators. 

 
 

 
 

Before you can generate reports from the Parallels RAS Console, MS SQL and the Parallels Reporting 
Service must be installed and configured. Before doing so, first check whether your machine complies with 
the prerequisites outlined below. Once confirmed, proceed with the three-stage process: MS SQL 
installation and configuration, Parallels Reporting Services installation, and Parallels RAS configuration. 

Supported Operating Systems – A machine running Windows Server 2008, 2008 R2, 2012, or 2012 
R2 with .Net 4.5 installed. 

Database Engine – Microsoft SQL Server 2012, SQL Server 2008 R2 Service Pack 1, SP2, and SP3. 
 
 

 
 

Active Directory User Requirements – To view reports, a user must be created in the Active Directory 
with the following credentials: 

▪ Username: RASREPORTINGVIEW 

Note: 2012 SQL Express edition has a 10 GB database limitation. 

Note: On farm environments with multiple RD Session Hosts, gateways, or VDI servers, it is recommended that 
MS SQL is installed on a dedicated machine. 
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Install and Set Up MS SQL 
Reporting requires a database instance installed either on the same machine running Parallels RAS or on a 
different machine running within the Parallels RAS local network (recommended). 

 
 
 

Figure 183 – MS SQL Installation Setup 
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Setting Up Reporting 
Run the SQL Server setup file > Installation. Select “New SQL Server stand-alone installation or add features 
to an existing installation” to launch the setup. 

 
 

Figure 184 – MS SQL Installation Support Rules 

The Setup Support Rules page will attempt to identify any issues during the SQL Server Setup Support Files 
installation. Upon completion, click “Next” to continue. 
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Figure 185 – MS SQL Installation Product Key 

Enter the product license key, click “Next,” and accept the license terms to continue to the “Setup Role” 
dialog. 

 

Figure 186 – MS SQL Installation Role Setup 

Next, select “SQL Server Feature Installation” and click “Next.” 
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Figure 187 – MS SQL Installation Feature Selection 
 
 

Next, enable the features listed below that are required for Parallels RAS reporting and click “Next” to 
continue: 

▪ Database Engine Services 

▪ Reporting Services – Native 

▪ Management Tools 
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Figure 188 – MS SQL Installation Instance Configuration 

Parallels RAS Reporting Services require the SQL server to be configured using a specific named instance. 
 
 

From the Instance Configuration page, select the option “Named instance,” input the information 
below, and click “Next” to continue: 

▪ Named Instance: RASREPORTING 

▪ Instance ID: RASREPORTING 
 
 

Without the above named instance, the Parallels Reporting setup will not complete. 
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Figure 189 – MS SQL Installation Server Configuration 

Subsequently, the “Disk Space Requirements” and “Server Configuration” dialog boxes are shown. Confirm 
the information, and click “Next” to proceed. 
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Figure 190 – MS SQL Installation Database Configuration 

At the “Database Engine Configuration” window, select “Windows authentication mode” and add the users 
below as SQL Server administrators: 

▪ Systems Administrator 

▪ AD Administrator 

▪ System User 
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Figure 191 – MS SQL Installation Reporting Service Configuration 

The next step introduces the “Reporting Service Configuration” that is used by Parallels RAS to generate 
reports. Select the “Install and configure” option and click “Next” to continue. 
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Figure 192 – MS SQL Installation Summary 

From the “Ready to install” section, ensure that features to be installed include: 

▪ Reporting Services 

▪ Management Studio Tools 

▪ Database Engine 

The Instance Name must be: RASREPORTING 

Once confirmed, click “Install” to proceed. Upon completion, proceed to the verification process and port the setup 
procedures. 
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Figure 193 – MS SQL Login Interface 

Next, verify that the reporting services have been set up correctly. Open the “Reporting Services 
Configuration Manager.” 

Input the server name from the “Report Server Instance” dropdown, select “RASREPORTING” and click 
“Connect.” 

 
Figure 194 – MS SQL Configuration Manager Interface 

Verify that the “Report Service Status” reads “Started.” 
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Figure 195 – MS SQL Configuration Manager Web Service 
 
 

Verify that the “Web Service URL” is set to: ReportServer_RASREPORTING 

Next change the SQL Reporting Services default port to 8085 to avoid conflicts between Parallels RAS 
gateways and SSRS (port 80). For further information, the step-by-step procedure is outlined at 
http://kb.parallels.com/123634.

http://kb.parallels.com/123634
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Parallels RAS Reporting Setup 
At this stage, you will install Parallels RAS Reporting Services. Log in to the machine running MS SQL with 
an account that has administrative privileges (AD) and proceed to install. 

 
 

Download the latest version of the “Parallels RAS Reporting Service” setup from the Parallels website. 
 
 
 

 
Figure 196 – Parallels RAS Reporting Setup Installation 

 
 

Double-click the ParallelsRASReporting.msi setup file to run the installation wizard. Click “Next” when 
prompted. Review and approve the end-user license agreement and click “Next.” 
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Figure 197 – Parallels RAS Reporting Setup Installation: Destination Folder 

Specify the folder location from which Parallels RAS will be installed, click “Next,” and then “Install” 
to commit to the configuration and initiate the installation. 
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Figure 198 – Parallels RAS Reporting Setup: Installation Complete 
 
 

When this screen is displayed, you have successfully installed Parallels RAS Reporting. Click “Finish” to 
complete the installation. 
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Parallels RAS Management Console 
Configuration 
Reports are generated from the Parallels RAS Console. To generate reports, Parallels RAS must be 
configured to communicate with the reporting service. 

 

Figure 199 – Parallels RAS Reporting Configuration 
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To configure reporting from the Parallels RAS Console, go to RAS Console > Administration > Reporting. 
Click the “Reporting Engine” dropdown menu and select “Parallels Reporting.” 

▪ Server – Specify the IP address of the machine hosting your SQL database that the Reporting 
Service is installed on. If the database is located on the same machine where you have installed 
Parallels RAS, you can also use localhost. 

▪ Port – Specify the port used to communicate with the Parallels Reporting Service. 

▪ Prompt user for Login Details – If selected, this will prompt the user for AD credentials when 
generating reports. 

▪ Use following credentials – If selected, specify AD username and password to be used each time a 
report is generated. 

 
 

Click “Test Connection” to test the configuration, then “Apply” to commit the configuration. 
 
 

Note: The default user for viewing reports is RASREPORTINGVIEW. This is not created in Active Directory 
automatically; it has to be done manually during the installation process in SQL. Alternate users need to be 
configured in SSRS with browser permissions. 



Reporting 

Parallels RAS Training Manual    
246 

 

 

 
 

Viewing Reports 

Figure 200 – Parallels RAS Reporting Tab 

After the configuration is complete and the credentials are verified via the test button, switch to the 
Parallels Reporting category to generate and view reports. Note that the first time you view reports, you 
may be requested to add http://<Parallels RAS server domain/ IP address> as a trusted website. This will 
appear depending on the Parallels RAS machine’s “Internet Explorer Enhanced Security Configuration” 
settings. 

Figure 201 – Parallels RAS Reporting Tab 
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Available Reports 
Parallels RAS Reporting has 14 available reports to choose from. These reports can be exported and 
printed out. 

Reports are exported in the following formats: XML, CSV, PDF, MHTML, Excel, TIFF, and Word. 

▪ User Activity: 

▪ Shows all sessions produced by all users in the system. Report includes information about 
each session: active, idle, and disconnected time. 

▪ User Session Activity: 

▪ Shows all sessions produced by a single user. Report includes information about each 
session: active, idle, and disconnected time. 

▪ Devices Used by User: 

▪ Shows information about the devices being used by a user. Report includes information 
such as device vendor, device model, and total time used. 

▪ Client Operating System Used by User: 

▪ Shows the operating system being used by a particular user, as well as total time used. 

▪ Groups Activity: 

▪ Shows all sessions produced by all groups in the system. Report includes information such 
as active, idle, and disconnected time. 

▪ Group Sessions Activity: 

▪ Shows all sessions produced by a group in the system. Report includes information about 
each session produced by each user in the group, such as start, end, active, idle, 
disconnect, and total time. 

▪ Devices Used by Group: 

▪ Shows information about the devices being used by users that are members of a particular 
group. Report includes information such as device vendor, model, and total time used. 

▪ Client Operating System Used by the Group: 

▪ Shows the operating system being used by members of a particular group, including 
total time used. 

▪ Devices Used: 

▪ Shows all devices using the system. Report includes information such as  manufacturer, 
model, and the number of sessions opened by the device. 



Reporting 

Parallels RAS Training Manual    
248 

 

 

 
 

▪ Client Operating System Used: 

▪ Shows devices and corresponding operating systems that are using the system. Report 
includes information such as device model, operating system, and amount of devices. 

▪ RDP Version Used: 

▪ Shows the Parallels Client version, the device using that version, and how many of 
those devices are being used. 

▪ Sessions Activity on Server: 

▪ Shows the session activity of users on a particular server. Report includes information such 
as start, end, active, idle, and disconnect time. 

▪ Server Health by Server: 

▪ Shows server CPU and RAM usage for a particular server in a graph. 

▪ Applications Usage: 

▪ Shows information about the applications used in the system. Report includes information 
such as application name, number of times used, and the total time the application was 
used for. 
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Licensing 
The licensing section will allow you to view licensing details and enter a license key. 

The Parallels RAS trial version has a 50-user, 30-day trial period. After 30 days, you will need to activate 
the product with a valid key. 

 

 
 

Figure 202 – Licensing Information 

License and Activation 
Activating Parallels RAS requires a Parallels My Account. Once you have successfully subscribed for an 
account, then you can purchase a subscription from our website. 
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Figure 203 – Licensing Information Tab 

To activate your Parallels RAS license, click on the “Licensing” tab on the left-hand side pane of the console. 
Click “Manage your license...” 
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Figure 204 – Parallels Business Account Login 

A dialog box will appear for you to enter your Parallels Business Account credentials. If you have not 
registered for an account, click “Register…” and fill in all the required details. Once your account is set up, 
enter your email and password and click “Sign In.” 

 
 
 

 
Figure 205 – Parallels RAS Activation 

Once you have successfully logged in, another dialog box will appear. If you are already in possession of a 
license key, enter the key in the “Activate using license key” textbox and click “Activate.” If you do not have a 
license key, click on the “Purchase a license” link to redirect you to a webpage where you can obtain a license 
key. 
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Figure 206 – Parallels RAS Activated 
 

When the license key is activated, a dialog box appears stating that the license key has been successfully 
activated, as shown in Figure 206. 

 
 
 

 
Figure 207 – Synchronizing Sites Prompt 

Next, the application will prompt you to synchronize all the sites configured in the farm. 
 
 

` 



Licensing 

Parallels RAS Training Manual    
254 

 

 

 
 
 

 
 

Figure 208 – Synchronizing Sites 

If you have chosen to synchronize the sites, another dialog box will appear showing the progress status. 
Once the synchronization is complete, click “OK” to finalize. 

 
 

Figure 209 – Licensing Information 

Once Parallels RAS has been successfully authenticated, all details will be shown in the “Licensing 
Information” tab under the “Licensing” section, accessible from the left-hand side pane on the console, as 
shown in Figure 209. 
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What Is the HTML5 Client? 
Parallels HTML5 Client is a client application that runs in a web browser. Users can use Parallels HTML5 
Client to view, launch, and work with remote applications and desktop in a web browser. 

Compared to platform-specific Parallels Clients (Parallels Client for Windows, Parallels Client for iOS, etc.), 
Parallels HTML5 Client does not require end users to install additional software on their computers or 
mobile devices. Feature-wise, platform-specific Parallels Clients do give users more control over their 
Parallels RAS experience than the Parallels HTML5 Client. Nonetheless, Parallels HTML5 Client is a fully 
featured, platform-independent client that provides end users with an alternate method of working with 
remote resources published via Parallels RAS. 

The only requirement to use Parallels HTML5 Client is an HTML5-enabled web browser installed on a 
client device. Read on to learn how to configure the HTML5 connectivity and use the Parallels HTML5 
Client. 
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HTML5 Client Themes 
A theme is a combination of colors, title, icons, display language, and other items that users will 
experience when they open the Parallels HTML5 Client in their web browsers. 

To manage themes, navigate to Farm / Site / Themes in the Parallels RAS Console. The Themes view in the 
right pane displays the available themes. The list contains at least one default theme. This theme cannot 
be removed, but you can customize it as needed. In addition to the default theme, you can create your 
own themes. 

 
 

Open Parallels HTML5 Client 
To open the Parallels HTML5 Client, enter its URL in an HTML5-enabled web browser. The URL that you 
give to your Parallels RAS users depends on how it is configured in the Parallels RAS Console, and whether 
you have HTML5 Client themes defined in the Parallels RAS Console. 

 

Session Persistence 
The option to keep the Parallels HTML5 session persistent through a network failure or change is available 
through the usage of an HTTP cookie. The cookie file will be stored on the client’s device to keep track of the 
active applications and/or desktops on the session. 
 

Drag and Drop 
Users can now drag and drop a file from their local device directly to the server side by dragging it either to 
an application tab or the Parallels HTML5 Client tab. 
 

Tab Usage 
The published applications and desktops can now be opened either in a single browser tab with a session 
taskbar or in a new tab, similar to the Windows 10 taskbar feature. The currently active application or 
desktop will be marked in the case of a single browser tab usage. 
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Parallels Clients 
Parallels software has the following clients available: 

▪ Parallels Windows Client 

▪ Parallels Windows CE 

▪ Parallels Mac Client 

▪ Parallels iPad/iPhone Client 
▪ Parallels Android Client 

▪ Parallels Chrome Client 
▪ Parallels Linux Client 

 
 

The Windows and Linux clients can be downloaded from: 
parallels.com/products/ras/download/choose-trial/ 

The Mac and iPad/iPhone client must be download from the Apple store.  

The Android and Chrome client can be downloaded from the Google Play store. 

 
 

Figure 210 – RDP Client on Google Play Store 

http://www.parallels.com/products/ras/download/choose-trial/
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Figure 211 – RDP Client on Apple Store 
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Installing and Configuring Parallels Windows 
Client and RDP Connections 

 
There are multiple clients that can be used to connect to Parallels RAS, which can be downloaded at: 
parallels.com/eu/products/ras/download/links/ 

Figure 212 – Parallels Client for Windows(x64) 

Please ensure that the version downloaded matches the corresponding operating system. There are 
different versions for Windows and OS X depending on the bit or version of the OS. 

During the installation process for Windows clients, a Single Sign-On option can be selected to utilize 
domain credentials used for PC login as well as for the Parallels Client. It can be changed to the 
opposite state in the Options > General settings in the client. 

To add a new Parallels Connection or Remote Desktop Connection, select “File” from the Parallels 
Client menu. 

http://www.parallels.com/eu/products/ras/download/links/
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Figure 213 – Adding a New RDP Connection 

For a Parallels Client Connection, add the hostname or IP in the primary connection field. 
 

 
 

Figure 214 – Connection Properties 

Browsing to select the primary connection is also possible by selecting “…” 
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Figure 215 – Parallels RAS Connections 

The Client Connection Mode gives administrators the choice to make connections with or without using 
SSL. It also provide a means for making direct connections to RDS servers after the initial connection is 
made through the gateway. 
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In the “Connection Mode” field, there are four types of connections available: 
 
 
 

 
Figure 216 – RDP Client Connection Mode Settings 

Gateway Mode – Clients are connected to the Parallels Secure Client Gateway, and the connected session 
is tunneled through the first available connection. This mode is ideal for servers that are only reachable via 
the gateway and do not require a high level of security. 

Gateway SSL Mode – A connection is made as in the regular gateway mode, but the connection 
is encrypted. 

Direct Mode – Clients first connect to the Parallels Secure Client Gateway to determine the best 
available server, and then connect directly with that particular server. This is best used when the client 
and the server are on the same network. 

Direct SSL Mode – This connection is created as in the Direct Mode option, but the connection to 
the Parallels Secure Client Gateway is encrypted. 

 
 
 

 
Figure 217 – RDP Client Connection Port 

The port number can be changed in the Parallels Client but must also be changed in the Properties of the 
Gateway Agent under the Network or SSL tab, depending on the Mode being used. Port 3389 is the default 
port for RDC connections. 
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Figure 218 – Adding a Secondary Connection 

A secondary connection can be added as a failover in the event of the primary Gateway not being 
reachable. As with the primary connection, the hostname IP must be entered or selected and the mode 
must be chosen. 

 
 
 

 
Figure 219 – Alias Name 

 

Figure 220 – RCP Client Connections 
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An alias name can be entered to help make identifying connections easier. 
 
 
 
 
 

 
Figure 221 – Connection Logon Credentials 

 
 

The Logon section of the Parallels Client is used to enter and store user account information. “Auto Logon” 
can be selected to establish a connection to the Publishing agent when the user logs on to their computer. 
“Save Password” can be selected to retain the user’s password between sessions, thereby hastening the 
logon process. 
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Figure 222 – Connection Logon: Single Sign-On 

Single Sign-On (SSO) can be selected to use the current domain’s credentials used to log on to the 
computer. This is used for domains that require users to change their password regularly and keeps the 
Parallels Client passwords current. Note that the credentials are “greyed out.” 

To configure other features of the Parallels Client, a copy of the manual for each respective client can be 
downloaded from: 

parallels.com/eu/products/ras/resources/ 

Parallels Client for Linux allows the same functionality provided by other Parallels Clients—mainly, 
connectivity to a Parallels Farm or via RDP to a desktop. 

The Parallels Client for Linux has been approved for the following 32bit Linux Distributions: 
 
 

▪ Ubuntu 

▪ openSUSE 

▪ Fedora Core 

▪ Fedora 15 

▪ CentOS 
 
 

The Parallels Client for Linux can be downloaded directly from the Ubuntu Directory or through the 
Parallels downloads page: parallels.com/eu/products/ras/download/links/ 

Different packages for the Parallels Client for Linux have been made available in different formats, mainly: 

1 .deb 

2 .rpm 
3 .tar.bz2 

4 SSO bundled in the .deb package 

http://www.parallels.com/eu/products/ras/resources/
http://www.parallels.com/eu/products/ras/download/links/
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Installing Parallels Linux Client 
These different packages can be installed by executing the relevant installation processes to the distros 
terminal. 

 
 

Installation Procedures (DEB Version): 

1 Switch to the root user. 

2 To install, type: dpkg -i ParallelsClient.deb 

3 Parallels Client for Linux binaries are now installed under: /opt/Parallels/Client/bin 

4 Run the following command to launch Parallels Client: 

/opt/Parallels/Client/bin/ParallelsClient 
5 You can also run the following commands to obtain a list of all usage parameters for Parallels 

Client session: cd /opt/Parallels/Client/bin./appserverclient -? 
 
 

Installation Procedures (RPM Version): 

1 Switch to the root user. 

2 To install, type: rpm –ivh ParallelsClient.i386.rpm 

3 Parallels Client for Linux binaries are now installed under:/opt/Parallels/Client/bin 
4 Run the following command to launch the Parallels Client: /opt/Parallels/Client/bin/ParallelsClient 

5 You can also run the following commands to obtain a list of all usage parameters for Parallels 
Client session: cd /opt/Parallels/Client/bin./appserverclient -? 

 
 

Installation Processes (.TAR.BZ2 Version): 

1 Switch to the root user. 
2 Switch to the root folder: cd/ 

3 To install type: tar jxvf ParallelsClient.tar.bz2 

4 Parallels Client for Linux binaries are now installed under: /opt/Parallels/Client/bin 

5 Run the following command to launch Parallels Client: /opt/Parallels/Client/bin/ParallelsClient 

6 You can also run the following commands to obtain a list of all usage parameters for Parallels 
Client session: cd /opt/Parallels/Client/bin./appserverclient -? 
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SSO (Single Sign-On) Installation Procedures: 

1 Install pam_Parallelsclient.so module to have Single Sign-On for Parallels Client. 

2 The module always returns true and will use an authentication token that will be provided by a 
higher authentication module. 

 
 

 
 

3 To install the Parallels Client PAM module, add two lines to your session manage service (eg. 
/etc/pam d/gdm): 

▪ auth optional pam_Parallelsclient.so 

▪ password optional pam_Parallelsclient.so 
 
 

Module arguments: 

▪ Debug: Debug trace will be written to /tmp/pam_Parallelsclient.log. If the file cannot be 
opened, then syslog will be used. 

▪ You can use debug argument with all module types, e.g. Session optional 
pam_Parallelsclient.so debug 

 
 

<service_list> The module will create an SSO cookie only for well-known session services. 

You can change the list of services to allow: EG. auth optional pam_Parallelsclient.so gdm kde kdm-kde4 
 
 

1 <service_list> The module will create an SSO cookie only for well-known session services. 
2 You can change the list of services to allow: EG. auth optional pam_ Parallels client.so gdm kde 

kdm-kde4 

Note: When a higher authentication module has been configured to SUFFICIENT, it will return on success 
immediately and pam_Parallelsclient.so won’t be called. Please change SUFFICIENT to REQUIRED. 
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Configuring Parallels Linux Client 
Once Parallels Client for Linux is installed, it’s only a matter of configuring the client so that it can 
connect to the proper resources. 

 
 

Just like the Windows client, Parallels Client for Linux can connect to a Parallels Farm or to a RD Session 
Host via the RDP Protocol. 

 
 

When adding a Parallels Connection through File > Add New Parallels Connection, the following details will 
be required: 

 

 
1 Hostname/IP Address of the Parallels Client Secure Gateway you are connecting to 
2 Connection Mode 

3 Port 

4 Username 

5 Password 
6 Domain 

 
 

When adding a new RDP connection through File > New Remote Desktop Connection, the 
following details will be required: 

 

 
1 Hostname/IP Address of the machine you want to connect to 

2 Ports 

3 Username 

4 Password 
5 Domain 
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Adding a Parallels Connection 

Figure 223 – Linux Client Connection Properties 
 
 

Adding an RDP Connection 

Figure 224 – Linux RDP Client Connection Properties 
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Parallels Client for Linux allows users to access remote desktops and files. The ability to run remote 
applications seamlessly over a secure channel is also possible. 

 

 

Figure 225 – Linux Parallels Client Published Applications 
Apart from the standard baseline functionality that the Parallels Client provides, the Linux client also 
comes with a command line interface that can be accessed through the following command: 

Usage: /opt/Parallels/Client/bin/appserverclient -s Server -u User [options] 

Some examples of possible commands are: 

appserverclient -s<Server IP> -a<"Application Name"> -u<User Name> 

appserverclient -s192.168.0.1 -a"Internet Explorer" -u Administrator 

The Parallels Client for Linux Manual contains a comprehensive list of possible command line options. 

http://kb.parallels.com/eu/123304
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Configuring Linux Peripherals 

Figure 226 – Linux RDP Client Local Resources Settings 
 
 

The Parallels Client for Linux allows the usage of the following local resources when logged on to the 
remote computer: 

1 Disk Drives 

2 Printers 

3 Serial Ports 

4 Smart Cards 

All of these options can be configured from the Local Resources Tab under Connection Properties. 

Under the same configuration pane, you are also able to configure whether sound redirection from 
the remote computer should be redirected to the client machine. 

Another option is the ability to apply Windows key combinations for desktops that would make the 
usage of shortcuts available, such as alt + tab. 

Redirection of local printers is also possible by configuring the printer in the options dialog of the Parallels 
Client for Linux. 

The user is expected to input the printer name as well as the driver to the printer list under the Printing 
Options tab under the Parallels Client for Linux Options. 
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Microsoft PowerShell 
Parallels RAS enables administrators to manage their Parallels RAS deployments using Microsoft 
PowerShell. The PowerShell module allows Parallels RAS administrators to automate various configuration 
operations and create automatic scripts for repetitive and complex tasks. 

Windows PowerShell is Microsoft’s command line shell and scripting language. PowerShell is built on the 
Microsoft .NET Framework and helps in system administration. By providing full access to COM 
(Component Object Model) and WMI (Windows Management Instrumentation), PowerShell enables 
administrators to perform administrative tasks on both local and remote Windows systems. 

Parallels RAS PowerShell requires Parallels RAS 15.5 Update 2 or higher. Earlier versions of Parallels RAS 
cannot be managed in PowerShell. 

The following components must also be installed on the machine where you would be running the 
Parallels RAS PowerShell cmdlets: 

 

1. Windows PowerShell 3.0 or higher 
2. Microsoft .NET Framework 4.0 or higher 

This chapter will briefly explore the basic PowerShell cmdlets on a very high level. Further examples and 
step-by-step processes are demonstrated in the Parallels RAS Labs Manual. 
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Querying Parallels RAS Roles using PowerShell 

Figure 227 – PowerShell Querying Parallels RAS Roles 
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Pushing Parallels RAS RDS Agent using PowerShell 
 
 

 

Figure 228 – PowerShell Pushing Parallels RAS RDS Agent 
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Parallels RAS in Microsoft Azure 
Microsoft Azure is a collection of integrated cloud services that you can use to build, deploy, and manage 
applications through Microsoft's global network of datacenters. Azure has service level agreements (SLAs) 
that guarantee external connectivity at least 99.95% of the time. Using Azure lets you sidestep the cost of 
hardware and infrastructure for deploying Parallels RAS desktops and applications, providing the necessary 
resources for computing, networking, and storage. 

By using Parallels RAS with Microsoft Azure, you can benefit from all the features of Parallels RAS while 
integrating any current use of other Microsoft technologies, like Windows Server System Center and 
Hyper-V. Parallels RAS on Azure is fast to deploy, robust, scalable, and easy to manage. With Microsoft 
Azure, setting up virtual machines is quick, and you can adjust them as your requirements change over 
time. VMs on Azure support all Parallels RAS services needed for a deployment. 

Leveraging Microsoft Azure capabilities, Parallels RAS supports the use case where backend services (such 
as Active Directory) are either deployed on-premise or using Azure. Therefore, Microsoft Office 365, Azure 
AD, and SQL server mixed with Federation Services are supported. Parallels RAS hosted on Azure consists 
of a small number of components: 

▪ Publishing Agent (controller) 

▪ Hosted shared workers (session isolation) 
▪ Server VDI workers (VM/server isolation) 

▪ Azure Active Directory Services or local AD controller (for failover purposes) 

▪ An Azure local SQL server VM instance (for reporting) 
▪ Corporate network, and Azure must be connected via site-to-site VPN 

All roles are supported in Azure, and the final architecture may vary depending on how much Azure will 
be utilized. Additional information about Parallels RAS requirements can be found in the Solution Guide. 
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Parallels RAS Azure Infrastructure 
Endpoint Access Using On-Premise 

 

 
Figure 229 – Azure Endpoint Access Using On-Premise 
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Endpoint Access Using Azure 
 

Figure 230 – Endpoint Access Using Azure 
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Multisite 
 

Figure 231 – Azure Multisite 
 
 

For end-user access, a couple of options should be considered: 

1. Existing customer end users can continue to use an existing URL (or gateway access) to leverage 
hybrid cloud deployment from an existing on-premise network. They can also add additional 
failover gateways from Azure Internet inbound networks. 

2. New customer end users can receive inbound traffic through Azure and use on-premise 
deployments later on. 
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All in Azure 
 

 
Figure 232 – All in Azure 

Leveraging Microsoft Azure capabilities, Parallels RAS supports the use case in which backend services 
(such as Active Directory) are deployed either on-premise or using Azure. Therefore, Microsoft Office 365, 
Azure AD, and SQL server mixed with Federation Services are supported. Parallels RAS hosted on Azure 
consists of a small number of components: 

▪ Publishing Agent (controller) 

▪ Hosted shared workers (session isolation) 

▪ Server VDI workers (VM/server isolation) 
▪ Azure Active Directory services 

▪ An Azure Local SQL server VM instance (for reporting)
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Virtual Machine Requirements 
Virtual Machine Requirements in Azure 

 

VM Role OS CPU Memory Disk Requirements 

Publishing Agent 
Windows Server 

2012, 2012 R2/2016 
2 vCPUs 8 GB 40 GB 

Gateway 
Windows Server 

2012, 2012 R2/2016 
2 vCPUs 8 GB 40 GB 

RD Session Host/ 
Application Servers 

Windows Server 
2012, 2012 R2/2016 

4 vCPUs 16 GB 
Depends on use 

case 

High Availability 
Gateways 

Debian 2 vCPUs 4 GB 10 GB 

 
On-Premise Virtual Machine Requirements 

 

VM Role OS CPU Memory Disk 
Requirements 

 
Publishing Agent 

Windows Server 
2003SP1, > Windows 

Server 2016 

 
2 vCPUs 

 
8 GB 

 
40 GB 

 
Gateway 

Windows Server 
2003SP1, > Windows 

Server 2016 

 
2 vCPUs 

 
8 GB 

 
40 GB 

RD Session Host/ 
Application Servers 

Windows Server 
2003SP1, > Windows 

Server 2016 

 
4 vCPUs 

 
16 GB 

Depends on use 
case 

High Availability 
Gateways 

Debian 2 vCPUs 4 GB 10 GB 
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Azure Marketplace Virtual Machine Templates 
With the infrastructure requirements completed, Parallels RAS VMs can be deployed. There are 
two approaches: 

▪ Virtual machine templates from Azure Marketplace (preferred method) 

▪ Deploy Windows server datacenter instances in Azure and push Parallels RAS components 

 
Once selected, VMs are deployed in Azure or through an on-premise datacenter. You must connect 
them from the Parallels RAS Publishing Agent. 
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